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Limited Warranty on Media and Replacement

If you discover physical defects in the manuals distributed with an Apple product or in the media on which a 
software product is distributed, Apple will replace the media or manuals at no charge to you, provided you 
return the item to be replaced with proof of purchase to Apple or an authorized Apple dealer during the 90- 
day period after you purchased the software. In addition, Apple will replace damaged software media and 
manuals for as long as the software product is included in Apple’s Media Exchange Program. While not an 
upgrade or update method, this program offers additional protection for up to two years or more from the 
date of your original purchase. See your authorized Apple dealer for program coverage and details. In some 
countries the replacement period may be different; check with your authorized Apple dealer.

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY 
(90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentation, APPLE MAKES NO WARRANTY 
OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALITY, 
PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS 
SOFTWARE IS SOLD ‘AS IS,” AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS 
QUALITY AND PERFORMANCE.

IN NO EVENT WILL APPLE BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised 
of the possibility of such damages. In particular, Apple shall have no liability for any programs or data stored 
in or used with Apple products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL 
OR WRITTEN, EXPRESS OR IMPLIED. No Apple dealer, agent, or employee is authorized to make any 
modification, extension, or addition to this warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. This warranty gives you 
specific legal rights, and you may also have other rights which vary from state to state.

Important

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. See instructions if interference to radio or television reception 
is suspected.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio noise emissions 
from digital apparatus set out in the radio interference regulations of the Canadian Department of 
Communications.

Observation des normes—Classe B Le present appareil numerique n’emet pas de bruits radioelectriques 
depassant les limites applicables aux appareils numeriques de la Classe B prescrites dans les reglements sur 
le brouillage radioelectrique edictes par le Ministere des Communications du Canada.
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Radio and television interference
The equipment described in this manual generates and uses radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause 
interference with radio and television reception.

This equipment has been tested and complies with the limits for a Class B computing device in 
accordance with the specifications in Part 15 of FCC rules. These specifications are designed to 
provide reasonable protection against such interference in a residential installation. However, there 
is no guarantee that the interference will not occur in a particular installation.

You can determine whether your computer is causing interference by turning it off. If the 
interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct 
the interference by using one or more of the following measures:

■ Turn the television or radio antenna until the interference stops.

■ Move the computer to one side or the other of the television or radio.

■ Move the computer farther away from the television or radio.

■ Plug the computer into an outlet that is on a different circuit from the television or radio. (That 
is, make certain the computer and the television or radio are on circuits controlled by different 
circuit breakers or fuses.)

■ Install a rooftop television antenna with a coaxial cable lead-in between the antenna and the 
television.

If necessary, consult your authorized Apple dealer or an experienced radio/television technician for 
additional suggestions.

You may find helpful the following booklet, prepared by the Federal Communications 
Commission: How to Identify and Resolve Radio-TV Interference Problems (stock number 004-000- 
00345-4). This booklet is available from the U.S. Government Printing Office, Washington, DC 
20402.

A Important Changes or modifications to this product not authorized by Apple Computer, Inc., 
could void the FCC certification and negate your authority to operate the product. This product was 
tested for FCC compliance under conditions that included the use of shielded cables and 
connectors between system components. It is important that you use shielded cables and 
connectors to reduce the possibility of causing interference to radios, television sets, and other 
electronic devices. For Apple peripheral devices, you can obtain the proper shielded cables from 
your authorized Apple dealer. For non-Apple peripheral devices, contact the manufacturer or dealer 
for assistance. A



Preface Welcome

This guide tells you how to set up and start using the Apple IIgs®—the most powerful and 

flexible computer in the Apple® II family. Each chapter describes activities that are basic to 

using your computer. These activities include:

■ setting up your computer

■ preparing and using disks

■ starting to work with software programs

■ saving, copying, organizing, and printing your work

If you are new to computers, if you’ve never used an Apple IIgs or Macintosh® computer, 

or if you need a quick review of basic computer information and skills, this book provides 

what you need.

For new and experienced users alike, this book contains valuable information about 

connecting other devices to the Apple IIGS and about troubleshooting the computer 

system.



How to use this guide
This guide is designed to walk you through the steps of setting up your Apple IlGS computer 
and learning to use it. Because you also have the option of using the tour disk, Your Tour of 
the Apple IlGS, you may not need to read all of this book. Instead, you may use it to refresh 
your memory about skills and tasks you learn in the tour. In any case, you’ll be using this 
book with your computer turned on, so that you can look at the objects and practice the 
actions described as you read.

If you don’t use the tour, and if you’re new to computers or you haven’t used a computer 
before, it’s a good idea to go though the chapters in order; later chapters build on the 
information in earlier ones. By the time you finish, you’ll be ready to put your computer to 
work.

Here’s what you’ll find in this guide:

■ Chapter 1, “Setting Up Your Apple IlGS,” shows you how to put together the 
components of your computer system.

■ Chapter 2, “Using the Apple IlGS Tour,” explains how to start your on-line tour, go 
through it, and then stop it. If you use the tour, you can skip or skim through Chapters 
3 through 7; they cover material similar to that in the tour.

■ Chapter 3, “Getting Ready to Use Your Computer,” tells you how to use the mouse and 
keyboard to give commands to your computer, and how to customize your computer 
work space.

■ Chapter 4, “Preparing and Using Computer Disks,” shows you how to get your disks 
ready to store your documents, and how to view the contents of disks.

■ Chapter 5, “Using Application Programs,” explains how you use software programs to 
accomplish tasks with your computer.

■ Chapter 6, “Copying Documents and Disks,” teaches you the various ways to create 
copies of computer data or information.

■ Chapter 7, “Organizing Your Work,” shows you how to store your work efficiently.

■ Chapter 8, “Printing Your Work,” provides basic information about printing your 
documents.
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■ Chapter 9, “Connecting Additional Devices,” tells you how to connect one or more of 
the many optional peripheral devices that expand the usefulness of the Apple IIgs 
computer.

■ Appendix A, ‘Additional Resources,” provides information on where to find more 
material to help you with your computer.

■ Appendix B, “Basic Computer Information,” explains basic computer terminology.

■ Appendix C, “Text Control Panel,” provides information on how to use the text Control 
Panel when the desktop Control Panels are unavailable.

Conventions used in this book
Some computer terms are printed in boldface type when first introduced. The boldface 
indicates that the term is in the glossary. The glossary provides more detailed explanations 
of terms than can be given conveniently in the text.

In sections that give step-by-step instructions for performing a procedure, numbered 
steps explain briefly what you need to do. There’s usually a sentence or two following each 
step, with elaboration and background information. If you’re eager to get through the 
procedure, you may find it easier to read just the boldface steps; but the complete 
information is always there for you if you want it.

The following paragraphs illustrate several typographical conventions that are used in 
this book to help make learning easier.

▲ Warning Warnings like this one alert you to situations in which you might damage your 
equipment or lose data if you don’t follow the instructions carefully. A

A Important Material set off like this is essential; read it before continuing. A

♦ By the way Paragraphs like this one contain interesting sidelights or information for 
specific audiences. ♦

Conventions used in this book xi



Figure P-1 Symbols used to show clicking, double-clicking, dragging and pressing.

In illustrations of screens, a blue check mark is used to show the action ofclicking, two blue 
check marks show double-clicking, a dotted blue line is used to show the action of 
dragging, and a downward pointing arrow is used to indicate pressing. Figure P-1 shows 
these symbols.
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Making choices and experimenting
With your Apple IlGS computer, there are often several ways to accomplish the same task. 
You can choose the method of doing a task that’s easiest or most useful for you.

Some people are concerned that they’ll have to learn all the methods of doing tasks at 
once. This guide does not explain every possible way to do the tasks it describes; it explains 
one or two ways that are easy to remember.

When you’re ready for more, you can turn to the Apple IlGS System 6 User’s Reference. 
Whenever you want a quick review of a basic task, you can return to this book.

Many people are also concerned at first about making a mistake that will damage their 
computers or their work. But you don’t need to worry. If you set up and operate your Apple 
IlGS according to the instructions and don’t spill liquids on the keyboard or computer, you 
won’t hurt your equipment.

What about the information in the computer? The Apple IlGS stores information on disks. 
Simply using a disk—putting it in a disk drive, viewing its contents on the screen, or ejecting 
it in the proper way—will not damage the disk or the information.

Just note the following disk precautions (see Figure P-2):

■ Don’t slide the metal shutter of a floppy disk aside and touch the disk itself.
(This can damage the surface of the disk.)

■ Be careful not to spill liquids on floppy disks. (If liquids get inside the plastic casing, they 
can damage the disk.)

■ Don’t expose your floppy disks to extreme temperatures—either too hot or too cold.
Even leaving them in direct sunlight can be dangerous. (Temperatures between 50 and 
125 degrees Fahrenheit are acceptable.)

■ Don’t use erasers on your floppy disk labels. (Eraser shavings can work themselves 
behind the metal shutter, keeping it from operating properly; or they can even get 
inside the casing itself, damaging the surface of the disk.)

■ Keep floppy disks away from magnets, or devices that contain magnets, such as 
telephones, stereo speakers, and the like. In particular, don’t set disks on your 
computer, disk drive, monitor, or printer. (Magnets can damage the information on a 
disk.)

Making choices and experimenting xiii



Figure P-2 Disk handling precautions

You can’t break the Apple IlGS by experimenting. In fact, experimenting is the best way 
to learn more about how the computer works. However, you can erase your data or 
information if you make an incorrect choice, so be sure to back up your documents and 
software programs and to work from duplicates.

This book assumes that you are using at least two 3.5-inch floppy disk drives with 
your computer system, or at least one 3.5-inch floppy disk drive and a hard disk drive.

If you don’t have a hard disk drive, you’ll need to use a 3.5-inch floppy startup disk each 
time you turn on the computer. The Apple IlGS comes with such a disk, called System.Disk, 
which has the necessary system software to start up the computer. You can also create your 
own floppy startup disks, as described in Chapter 2 of the Apple IlGS System 6 User’s 
Reference.



Important If you have a hard disk drive, you’ll need to initialize it according to the 
instructions in the manual that came with your SCSI card. Then you’ll need to refer to 
Chapter 2 of the Apple IlGS System 6 User’s Reference to learn how to install system software 
on your hard disk. However, if you’ve never used an Apple IlGS or Macintosh computer 
before, it’s a good idea to use the tour disk, Your Tour of the Apple IlGS, and then practice 
the mouse, menu, and icon exercises in Chapter 3 before you go about initializing your hard 
disk. A

What’s in the box
Before you go on, unpack the Apple IlGS boxes and make sure you have all the items shown. 
See Figure P-3 for illustrations of the appropriate pieces.

■ Apple IlGS computer and power cord

■ Keyboard and cable

■ Mouse

■ Apple IlGS monitor and cable

■ Your Tour of the Apple IlGS disk

■ System software disks (6)

■ Apple IlGS System 6 User’s Reference

■ Apple IlGS Owner’s Guide

■ A packing list, detailing all contents

If you’re missing anything, contact your authorized Apple service provider. If you have 
everything, fill out the warranty card and mail it in. (The warranty card asks for the serial 
number of your computer; you’ll find this number on the bottom of the computer.)

You should also gather together any other components (printer, modem, and disk drives) 
you’ve purchased for use with your Apple IlGS. Make sure you have the necessary power 
cords and cables for your equipment. (The owner’s guides that came with the components 
will tell you what you need to connect them. Chapter 9, “Connecting Additional Devices,” 
starting on page 109, also provides useful information.)

What’s in the box xv



Figure P-3 What you should have
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It’s also a good idea to keep a supply of blank disks on hand; you’ll need one to follow 
the instructions in this book, and several to make copies of your important disks. Unless 
you’re working primarily with a hard disk, you’ll also need a supply of disks as soon as you 
start using the computer for your own work.

When you have everything you need, turn to Chapter 1, “Setting Up Your Apple IlGS,” for 
instructions on setting up your Apple IlGS system.

What’s in the box xvii





1 Setting Up Your Apple IlGS

This chapter explains how to set up your Apple IlGS computer and how to connect some 

basic components to it. Unless someone has already set up your computer system for you, 

you’ll need to read this chapter.

Setting up your Apple IlGS shouldn’t take long. The task will be easier if you allow yourself 

plenty of room for the initial setup. Once everything is installed and connected, you can 

place the monitor on top of the computer and position the computer the way you want. 

But until everything is plugged in, give yourself easy access to the back panel of the 

computer.



Important safety instructions
Before you begin setting up your Apple IIgs, you should read these important safety 
instructions.

▲ Warning This equipment is intended to be electrically grounded.
Your Apple IlGS is equipped with a three-wire grounding plug—a plug that has a third 

(grounding) pin. This plug will fit only a grounded AC outlet. This is a safety feature. If you 
are unable to insert the plug into an outlet, contact a licensed electrician to replace the 
outlet with a properly grounded outlet. Do not defeat the purpose of the grounding plug 
by using an adapter; you may damage your new computer! ▲

For your own safety and that of your equipment, always take the following precautions. 
Disconnect the power plug (by pulling on the plug, not the cord) if any of the following 
conditions exists:

■ The power cord or plug becomes frayed or otherwise damaged.

■ You spill anything into the computer’s case.

■ Your Apple IIgs is exposed to rain or any other excess moisture.

■ Your Apple IIgs has been dropped or the case has been otherwise damaged.

■ You suspect that your Apple IIgs needs service or repair.

■ You want to clean the case. (Use only the recommended procedure described at the 
end of this section.)

Be sure that you always do the following:

■ Keep your Apple IIgs away from sources of liquids, such as beverage containers, wash 
basins, bathtubs, shower stalls, and so on.

■ Protect your Apple IIgs from dampness or wet weather, such as rain and snow.

■ Read all the installation instructions carefully before you plug your Apple IIGS into a 
power outlet.

■ Keep these instructions handy for reference by you and others.

■ Follow all instructions and warnings dealing with your system.

2 Chapter 1 Setting Up Your Apple IIGS



▲ Warning Electrical equipment may be hazardous if misused. Operation of this product, or 
similar products, must always be supervised by an adult. Do not allow children access to the 
interior of any electrical product and do not permit them to handle any cables. ▲

To clean the computer’s case, do the following:

1. Disconnect the power cord. (Pull on the plug, not the cord.)

2. Wipe the surfaces lightly with a clean, soft cloth dampened with water.

Plugging in the components

The Apple IIgs has a row of sockets, known as ports, on its back panel. Most components 
can be plugged directly into ports on the computer. Figure 1-1 shows the ports and other 
features on the back panel of the Apple IIgs. Below each port is a visual symbol, called an 
icon, that represents the type of component you plug into the port. For example, the disk 
drive port is marked with the icon of a disk.

Port openings Power cord socket On/off switch

Modem port

Headphone 
jack

Monochrome or 
composite color 
monitor port

ADB port for 
keyboard and 
mouse

Printer port (also for another 
serial device or LocalTalk 
network)

Hand-operated 
control port 
(for joystick, 
game paddles)

Disk drive Analog RGB color
port or monitor port
Smart Port

Security cable connector

Figure 1-1 Apple IIGS ports
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Figure 1-2 Components that you connect to your Apple IlGS

In addition to the ports on the back panel of the computer, there’s a row of seven 
narrow sockets, known as slots, as well as a single memory slot inside the computer.

Some components—external hard disks, for example—are not designed to use the 
computer’s ports and must be connected to a card in one of these internal slots instead. If 
you have one or more such components, be sure to read Chapter 9, “Connecting Additional 
Devices,” starting on page 109, for information about connecting them to the computer.

Figure 1-2 shows the components you’ll connect—either directly or indirectly—to the 
ports on the back panel of the Apple IlGS.

4 Chapter 1 Setting Up Your Apple IlGS



Warning Before you connect any components to your Apple IIgs, the computer’s power 
should be switched off. (If the green light on the front of the computer is on, the power is 
still on.) If the power has been on, wait at least 15 seconds after switching off the power 
before connecting or disconnecting components. ▲

Plugging in the power cord

Before you connect any components, you need to plug in the computer’s power cord so 
that the computer is grounded. Follow these steps:

Make sure the computer’s power switch is set to O for Off.

Plugging in the components



Plug the three-hole end of the power cord into the power cord socket on the back 
panel of the computer.

Plug the three-prong end of the power cord into a grounded outlet.

If you have more than two components that need to be plugged into the wall, you should 

use a power strip, available from most hardware stores. Some power strips include a device 
called a surge protector that prevents your equipment from being damaged by a surge of 
voltage. It’s a good idea to use a power strip with a surge protector—especially if your home 
or office occasionally experiences power fluctuations.

6 Chapter 1 Setting Up Your Apple IlGS



A Important Leave the power cord plugged into a grounded outlet while connecting or 
disconnecting any components. (And if your computer is plugged into a power strip, leave 
the power strip switched on.) Doing so keeps your computer system grounded.

For clarity, the figures in the following sections show only the cables and cords involved 
in the particular procedure being described. Your system may have more cables and cords 
connected to it than are shown in any one figure. A

Connecting the keyboard and mouse

Follow these steps to connect the keyboard and mouse:

With the keyboard facing you, plug either end of the keyboard cable (flat side 
up) into one of the connectors on the keyboard.

2 Plug the other end of the keyboard cable (flat side up) into the keyboard port on 

the back panel of the computer.

Because you will “chain’' the mouse to the keyboard, the keyboard port 
is marked with the icon of a chain of devices. (The same icon appears on 
the ends of the keyboard cable and mouse cable.)

Plugging in the components 7



Plug the mouse cable (flat side up) into the other connector on the keyboard.

If you’re left-handed, you may want to plug the keyboard cable into the connector on the 
right and the mouse cable into the connector on the left.

8 Chapter 1 Setting Up Your Apple IlGS



Connecting the monitor
Follow these steps to connect the monitor to your Apple IlGS:

1 Connect one end of the monitor cable to the back of the monitor and tighten the
thumbscrews.

2 Connect the other end of the monitor cable to the monitor port on the back 

panel of the Apple IIgs and tighten the thumbscrews.

The monitor port is marked with the icon of a video screen with three 

circles.

3 Plug the three-prong end of the monitor’s power cord into a grounded outlet.

Plugging in the components 9



Figure 1-3 Connecting an Apple 3-5 Drive to your Apple IlGS

Connecting Apple 3.5 Drives

This section explains how to connect Apple 3-5 Drives to your Apple IlGS. For instructions 
on how to connect 5.25-inch or UniDisk™ drives, see Chapter 9, “Connecting Additional 
Devices,” starting on page 109. For instructions on connecting an Apple SuperDrive high- 
density drive, consult the manual that comes with the drive.

When connecting more than one drive, you use a technique called daisy-chaining: 
You connect the first drive directly to the disk drive port on the computer, then you connect 
the second drive to the first drive, and so on.

You can daisy-chain as many as four drives to the disk drive port, but only two Apple 3-5 
800K Drives. For information about daisy-chaining other types of drives see Chapter 9.

♦ Reminder If you plan to connect Apple SuperDrives, be sure to connect them before 
any 800K drives. If you plan to connect Apple 5.25 Drives, be sure to connect all Apple 3.5 
Drives before connecting any 5.25-inch drives. ♦
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Figure 1-3 shows how to connect the first disk drive to your computer. Follow these steps:

Make sure the computer is plugged in and its power is switched off.

Double-check to make sure that the power switch is set to 0 for Off before you connect any 
disk drives. If the power has been on, switch off the computer and wait at least 15 seconds 
before you connect your disk drive.

▲ Warning Connecting a drive when the power is on, or within 15 seconds of switching off 
the power, could seriously damage your disk drive or your computer. ▲

Connect the disk drive cable to the disk drive port on the back panel of the Apple 
IIgs and tighten the thumbscrews.

The disk drive port is marked with the icon of a disk.

Plugging in the components 11



If necessary, use a nail file or small screwdriver to remove the plastic plate that 
covers the port on the back of the disk drive already connected to the computer.

Connect the disk drive cable of the next drive to the port on the back of the 
connected disk drive and tighten the thumbscrews.

Keep in mind that you shouldn’t daisy-chain more than four drives to the disk drive port— 
and no more than two Apple 3.5 Drives. For information about daisy-chaining other types 
of drives, see Chapter 9.

12 Chapter 1 Setting Up Your Apple IlGS



Use the labels that came with your Apple 3.5 Drives to specify which is drive 1 
(the first drive in the chain) and which is drive 2 (the second drive in the chain).

If you have other components to add to your Apple IlGS system, refer to Chapter 9, 
“Connecting Additional Devices,” starting on page 109, for further information. If your 
Apple IlGS is connected to a network, you’ll find complete information on using network 
services in Chapter 12 of the Apple IlGS System 6 User’s Reference. If you’ve never used an 
Apple IlGS or Macintosh computer, you should go through all steps of the tour disk, Your 
Tour of the Apple IlGS, or read all of Chapters 3 through 8, before turning to the user’s 
reference. (You’ll need to know some basic computer skills in order to complete some of 

the procedures described in Apple IlGS System 6 User’s Reference.)

When everything is connected, arrange the components in a way that’s convenient for you. 
You may want to place the monitor on top of the computer, for example, to conserve desk 

space. Figure 1-4 shows an Apple IlGS set up this way.

Figure 1-4 Apple IlGS, monitor, and 3.5-inch disk drives arranged to conserve space
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2 Using the Apple IlGS Tour

This chapter explains how to start up and stop the tour disk Once you’ve started the tour, 

directions for navigating through the information will appear on the screen.

If you prefer to learn basic tasks from this guide rather than from the tour, go on to 

Chapter 3, “Getting Ready to Use Your Computer,” starting on page 23.

If you’ve used an Apple IIgs or Macintosh computer before, you may want to skip the tour 

and begin using the computer right away. In that case, you can refer to Chapters 3 through 

8 or to the Apple IIgs System 6 User’s Reference when you need a reminder about how to 

perform specific tasks.



Identifying your startup drive
Before you start up the tour disk, you need to know which disk drive is your startup drive. 
The startup drive is the one in which the computer looks first for a startup disk—a disk 
that contains the software the computer needs in order to operate.

Use these guidelines to identify your startup drive:

■ If you have two or more drives of the same size, the startup drive is the one connected 
directly to the computer.

■ If you have a hard disk connected to slot 7, the hard disk is your startup drive.

■ If you have both a 5-25-inch drive and an 800K, 3-5-inch drive connected directly to 
the computer, the 5.25-inch drive is your startup drive. If you want the computer to start 
up from a disk in your 3-5-inch drive instead—for example, when you want to use the 
Apple IlGS tour disk—make sure the 5.25-inch drive is empty and its door is open. When 
the computer can’t find a disk in the 5.25-inch drive, it checks the 3-5-inch drive next. 
(There is a way to direct the computer to bypass your 5-25-inch drives when it looks for 
the startup drive. You can learn about it later in Chapter 3 of the Apple IlGS System 6 
User’s Reference. For now, just leave the door open.)

■ If you have drives connected to the computer’s internal slots, the startup drive is the 
one connected to the card in the highest-numbered slot. (For information on 
connecting devices to the computer’s internal slots see Chapter 9, “Connecting 
Additional Devices,” starting on page 109.)

■ Some cards allow two drives to be connected directly to the card. In such a case, the 
startup drive is the one attached to the connector labeled Drive 1 on the card.

It is possible to change the startup drive. You can learn about it later in Chapter 7 of the 
Apple IIgs System 6 User’s Reference.

Starting the tour
The quickest way to become familiar with your Apple IlGS is to start using it. That’s the 
purpose of Your Tour of the Apple IlGS.
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Follow these steps to start the tour:

1 Put the Your Tour of the Apple IlGS disk in your startup drive, metal end first and 
label side up.

2 Switch on the monitor.

The power switch is on the right side, near the top of the monitor case. When you switch 
on the monitor, the green light in the lower-right corner of the front of the monitor 

comes on.
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3 Switch on the computer.

To switch on the computer, reach around the left side of the computer and find the power 
switch on the left side of the back panel. Press the top half of the switch to turn the 
computer on.

Several things happen:

■ The computer beeps.

■ The green light on the front of the computer comes on.

■ The light on your startup drive comes on and the drive begins to hum intermittently as 
it loads information into the computer’s memory.

In a few moments you see the message “Welcome to the IIgs.” If you don’t see it, read the 
next section, “If you have problems starting up.”

Set this guide aside and enjoy a hands-on introduction to your Apple IIgs.

Everything you need to know to take the tour is explained on the computer’s screen. You 
don’t need to complete the entire tour at one sitting; you can stop at any time. When you’re 
ready to stop, turn to “Stopping the tour disk," on page 20, for instructions.
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If you have problems starting up
If you don’t see the message “Welcome to the IIgs” after starting up the tour disk, go 
through the following checklist to try to identify the problem. If you can’t identify the 
problem yourself, get help from a more experienced Apple II user or from your authorized 
Apple service provider.

▲ Warning If you suspect a loose connection, be sure to switch off the power and wait at 
least 15 seconds before you secure the connection. ▲

Follow these steps to isolate the problem: 

■ Make sure the computer is plugged into a grounded power source.

• Make sure the monitor is plugged into a grounded power source.

■ If the computer and monitor are plugged into a power strip, make sure the power strip 
is switched on and plugged into a grounded outlet.

■ Make sure the monitor is connected to the computer.

■ Make sure the computer is switched on (the green light in the lower-right corner of the 
computer should be on).

■ Make sure the monitor is switched on (the green light should be on).

■ Check the monitor’s contrast and brightness settings.

■ If you have a 5.25-inch disk drive connected to the computer, make sure that the disk 
drive is empty and that its door is open before you switch on the computer’s power.

■ Make sure you’re using the correct disk. Eject the disk in the startup drive (following 
the instructions in the next section) and make sure it’s labeled Your Tour of the Apple

IIGS.

■ If the image on your screen is rolling or out of alignment, hold down the Option and 
Control keys while you press and release the Reset key (marked with a triangle) at the 
top of the keyboard (as shown in Figure 2-1), then press 2. (This procedure restores the 
standard frequency settings for the United States so that your monitor will receive 
signals from the computer at the proper frequency.)

■ Although it’s unlikely with a new computer, the startup slot may have been changed. To 
make sure it’s properly set, see Appendix C, “Using the text Control Panel Desk
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Figure 2-1 Restoring the standard settings

Accessory,” in this manual. For more information about slot settings, see Chapter 7 of 
the Apple 11GS System 6 User’s Reference.

Stopping the tour disk
When you’re ready to stop using the tour, follow these steps:

1 Press the Esc key to return to the main menu of the tour disk.
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Choose Conclusion from the Quit menu.

After the music stops, you see a message that tells you how to eject the disk or—if you want 
more practice—to return to the tour.

Make sure the disk drive light is off; then eject the disk from the disk drive.

▲ Warning Ejecting a disk while the disk drive light is on could cause information on the 
disk to be lost or could damage the disk drive. ▲

To eject the disk, push the eject button on the disk drive.

After taking the tour disk out of the drive, switch off the computer and monitor.

If you need to be reminded about some of the tasks you learned in the tour, you can find 
step-by-step instructions for most of them in Chapters 3 through 8, or you can refer to the 
Apple IlGS System 6 User’s Reference.
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3 Getting Ready to Use Your Computer

This chapter presents some fundamental concepts for working with your computer. It 

introduces you to the Apple IIgs desktop and gives you practice working with the basic 

skills you’ll use time and again to give instructions to your computer. It also shows you how 

to customize your computer to suit your own preferences.

If you haven’t looked at the Your Tour of the Apple IlGS disk, or if you’ve never used an Apple 

IIgs or Macintosh computer, work through this chapter before going ahead in this book.

A Important If you have a hard disk drive, you need to initialize it according to the 
instructions in the manual that comes with your SCSI card. Then refer to Chapter 2 of the 
Apple IIgs System 6 User’s Reference to learn how to install system software on your hard 
disk. However, if you’ve never used an Apple IlGS or Macintosh computer before, it’s a good 
idea to use the tour disk, Your Tour of the Apple IlGS, and practice the mouse, menu, and 
icon exercises in this chapter before initializing your hard disk. A



Window scroll bar

Scroll arrow

Folder icon

Window scroll bar Scroll arrow Trash icon

Figure 3-1 The Apple IlGS Finder desktop

Understanding the Finder desktop
The desktop is what you see on the screen each time you start up the Finder. It’s your 
working area—your base of operations—and it looks like Figure 3-1.

Insert the System.Disk in your startup drive—metal end first and label side up—and switch 
on the computer and monitor. (If you don’t know which drive is your startup drive, see 
“Identifying your startup drive,” on page 16.)

In a moment, you’ll see the desktop. The next sections explain how to use the mouse 
to work on the desktop.
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Figure 3-2 Holding the mouse

Using the mouse
This section explains how to move the pointer and how to use the mouse to give 
instructions to the computer.

A Important If you have difficulty manipulating the mouse, the Apple IIgs computer comes 
with programs designed to assist you. For information, see Chapter 10 of the Apple IlGS 
System 6 User’s Reference, a

Moving the mouse

It takes a little practice to use the mouse comfortably, so don’t be discouraged if it seems 
awkward at first.

■ Use the mouse with your dominant hand (right if you’re right-handed, left if you’re left­
handed), and always hold it with the cable pointing away from you.

■ The mouse is easier to control if you rest the heel of your hand on your desk (instead 
of holding your hand up in the air).

■ The direction that you move the mouse on your desk is the same as the direction that 
the arrow pointer moves on the screen.

■ The distances that the mouse and the pointer move are not necessarily the same. If the 
mouse moves an inch on your desk, for example, the pointer may move more than an 
inch on the screen.
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■ If you run out of room to move the mouse, you can pick it up and put it down 
somewhere else. Moving the mouse in the air does not move the pointer on the screen.

■ Don’t press down on the mouse while you’re trying to move it. When you see or hear 
the word “press,” it’s referring to the mouse button—not the entire mouse.

Mouse and pointer move the same direction

System.Disk

Mouse and pointer move different distances

* File Edit Windows View Disk Special Color

Pointer doesn’t move when the mouse is lifted Don’t press down on the mouse

Figure 3-3 Moving the arrow pointer by moving the mouse
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* File Edit Windows View Disk Special Color

System.Disk

Figure 3-4 Using the mouse to point to the Edit menu (left) and the Trash (right)

Practicing with the mouse

You can do all your work on the Apple IIgs computer (except type text and numbers) by 
using just a few mouse techniques. If you’re not comfortable with the mouse yet, practice 
these techniques on your desktop. (If you have a disability that requires you to do all your 
work by using the mouse, the Apple IlGS computer comes with a program designed to help 
you. For information see Chapter 10 of the Apple IIgs System 6 User’s Reference.)

Point

You point to an object on the desktop by moving the arrow pointer until the tip of the arrow 
is over that object.

Practice pointing to the disk icon, the Trash, and the Apple icon in the menu bar.
You need to be able to point before you can perform other mouse actions.

Click

You click by first pointing to an object, and then pressing and releasing the mouse button 
once. Don’t move the mouse while you click.

Practice clicking the Trash icon and then the disk icon.
When you click an icon, it becomes highlighted. Highlighted icons are black with a 

white outline.
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System.Disk

« File Edit Windows View Disk Special Color

Figure 3-5 Using the mouse to Click, Press, Drag, and Double-Click

Double-clicking

Manuals for Apple IlGS programs often use the words click and select to mean the same 
thing. In both cases, the action you take is the same: Position the pointer and dick the 
mouse button.

28 Chapter3 Getting Ready to Use Your Computer



Press

You press by first pointing to an object, and then pushing down steadily on the mouse 
button. Don’t move the mouse while you press.

Practice pressing all the titles of the menus in the menu bar. Move the tip of the arrow 
pointer over a menu title, and then press and hold down the mouse button (without 
moving the mouse). The menu appears below its title. When you’re finished looking at the 
menu, release the mouse button (still without moving the mouse).

Drag

You drag an object by first pointing to it, then pressing the mouse button, and then moving 
the mouse in the direction you want to move the object.

Practice dragging the Trash icon to other locations on the desktop. Move the tip of the 
arrow pointer over the Trash icon, press the mouse button, drag toward the top or left side 
of the screen, and then release the mouse button.

Notice that when you move the mouse, an outline of the icon moves along with the 
pointer. When you release the mouse button, the icon moves to the new location.
You can’t lose an icon by dragging it off the desktop—try it and see.

Double-click

You double-click by first pointing to an object, and then clicking the mouse button twice. 
Don’t move the mouse while you double-click.

Getting the timing right on a double-click sometimes takes a little practice. Practice double­
clicking the Trash icon. Notice that when you do this correctly, the Trash icon opens into a 
window.

=□---............. ...
fl items

Trash Pl=

o

£1_____________ ___________________________
lp"l

Trash

Using the mouse 29



i You can close the window by clicking once in the small box at the upper-
0 items left corner of the Trash window. This box is called the close box.

Close the Trash window now by clicking once in the close box.

Using the menu bar
The Finder lets you do work without having to memorize commands. All the commands are 
available to you in the menu bar, and you can pull down a menu at any time to see which 
commands are there. The following list gives a brief explanation of what you can find in the 
menus. You’ll learn how to use some of them in the chapters of this manual, and you can 
find more detailed information about them in the Apple IIgs System 6 User’s Reference.

■ Apple (tf) menu: Useful information about the Finder; Help information; and the 

Control Panels, which let you customize many features of your computer. The Apple 
menu also provides access to any desk accessories you install on your startup disk.
(For more information about desk accessories, see Chapter 7 of the Apple llGS System 6 

User’s Reference.)

■ File menu-. Commands that help you manipulate files, folders, disks, icons, and 
windows.

■ Edit menu: Commands that help you edit text. These are generally used with programs 
in which you can type text.

■ Windows: A list of all the windows you can open as you work with the desktop. To work 
with any listed window, you choose it from the menu.

■ View: Commands that allow you to change the way information is displayed in a 
window.

■ Disk: Commands that let you perform basic procedures with your disks.

ft File Edit Windows View Disk Special Color

Figure 3-6 The Apple IIGS menu bar
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■ Special: Commands that let you align icons, discard files, set special preferences, get 
information about icons, and shut down the computer.

■ Color. Choices for changing icon background and outline colors.

■ Extras: A special menu that appears only if you have installed Finder extensions, 
programs that augment the features of the Finder. If your computer is connected to a 
network, for example, you may want to install Easy Mount, an extension that allows you 
to log on more conveniently. (For more information, refer to Chapter 12 of the Apple 
IIgs System 6 User’s Reference.) Other Finder extensions are available from third-party 
companies.

Recognizing icons
To understand what icons are, consider the kinds of objects you have in your office: 
drawers, file folders, pencils, and paper. The icons on your electronic desktop correspond 
to these objects.

Floppy disk icons are comparable to drawers. Just as a desk drawer can 
contain folders, documents, rulers, and paper clips, a disk can contain 
both your work and the tools you use to create it.

Hard disk icons represent a very large capacity “drawer” for holding 
your work and tools.

Folder icons are comparable to file folders. You use folders to organize 
and store your work so you can find it again later.

Application icons represent software programs, which are the tools 
you use to do your work. Application icons are often diamond-shaped, 
like the Teach icon shown here.

Document icons represent the documents that you create with your 
applications. Many document icons are shaped like a sheet of paper with 
one corner folded down.
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iiin A few icons, such as the Trash, have special functions that don’t fall into 
any of the categories above. These icons have correspondingly unique 
shapes.

Telling the computer what you want to do
You’ve learned that icons represent objects that you can use while you work. You’ve also 
learned that menus are lists of actions, also called commands, that you can take while you 
work.

Telling the computer what you want to do is a two-step process:

1. Identify the object you want to use.

2. Tell the computer what action to take.

Here is a simple example you can try on your own desktop. Let’s say that you want to see 
what’s in the Trash.

Select the Trash icon.

To select an icon, you move the arrow pointer over the icon and click the mouse button 
once. The icon becomes highlighted.

By selecting an icon, you tell the computer that you want to work with it.

Sometimes the icon you want to work with is already highlighted, in which case you can 
skip this step.

2 Choose the Open command from the File menu.

To choose a menu command, follow these steps:

■ Move the tip of the arrow pointer over the File title in the menu bar.

■ Press and hold down the mouse button to display the menu.

■ Drag the pointer down the menu to highlight the command you want.
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Release the mouse button to activate the command.

it File^ Edit

2. Display File menu

New'Volder 6H
Open 60
hint
Close
Close All

6W

Duplicote... 60
hit Awtsy
Validate

•tv

File
New Folder ~6N}
Open r. 60
hint
Close
Close All

6W

Duplicate... 60
hit Aw
Validate

■tv

1. Point to File Menu 3. Highlight Open

The Trash icon opens into a window. The window should be empty right now.

▲ Warning Don’t drag any icons to the Trash yet. You may inadvertently throw away 
something you need. ▲

Close the Trash window.

To close the window, click in its close box.

As mentioned earlier, there are often several correct ways to do tasks on the Apple IIgs . 
Among the correct ways are shortcuts that do not necessarily reflect the two-step process 
just described. For example, on page 29, you used a shortcut when you double-clicked the 
Trash icon to open it.

But you don’t need to memorize shortcuts. If you keep the two-step process in mind, 
you’ll often be able to figure out how to do things on your own.

In the next section, you’ll be working with icons and menus to customize your desktop.
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Customizing Your Work Space
Your Apple IlGS computer lets you change many of the computer’s features to suit your 
preferences. In this section, you’ll learn how to make some of the possible adjustments; you 
can find details about all the possibilities in the Apple lies System 6 User’s Reference.

One of the ways to customize the way your computer works is to use the Control Panels. 
With the Control Panels window open you can adjust several aspects of how the computer 
performs.

Follow these steps to open the Control Panels window:

Move the tip of the arrow pointer over the Apple icon at the left end of the menu 
bar.

«t File

Press and hold down the mouse button to see the menu.

Control Panels

a___
About the Finder...
Help 6?

Drag the pointer down until the words Control Panels are highlighted.

□ _
About the Finder...
Help (J?

Control Panels
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Without moving the mouse, release the mouse button.

The Control Panels window appears on your desktop.

=□= Control Panels

C Open 1
Printer Port

fn it ul 
ii^yZ

Time
( Help )

2.0

Setting the time and date

Your Apple IlGS has an internal clock. This clock can help you check the hour, or keep track 
of the date and time when you created a document. Once you set the clock, it needs no 
further attention until you want to change it for some reason or the internal battery runs 
down.

Follow these steps to set the time and date:

Find the lime icon at the left side of the Control Panels window.

=□== Control Pnnpls==

Shi

(( Hpw D
III ■ 111 ( Help )

Time ’

2.0
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2 Double-click the Time icon to open it.

You can also click the icon once and then click the Open button; double-clicking is the 
shortcut. The Time Control Panel window opens.

lime

■ Time =

6:05:07 PH
Mar 19 1992

Day 79 of this year. 
287 days left in this year.

® MM/DD/VV
O DD/MM/VY 
OW/MM/DD

®AM/PM
O 2H Hour

@Standard Time
ODaylight Time
□ Auto daylight savings

Even if the clock shows the correct time, you may want to skim the rest of this section to 
see how the procedure works.

To select the first item you want to change, click the number representing the 
hour, minute, or second.

5:t0g:00 PM$
Mar 1 .9 1992

Position the pointer over a number in the top box, and click the mouse 
button once. The number becomes highlighted.

To correct the number, click the small arrows at the right.

5: GE: 00 PM fj 
Mor 19 1992 |

Again, position the pointer over the up or down arrow and click. If you 
go too far, just click the other arrow to get back to the number you want.

Repeat steps 3 and 4 until all the numbers are correct.

When the clock setting is correct and you’re ready to set the date, the steps are almost 
identical.
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In the second box, click the month, day, or year.

To correct the value, click the small arrows at the right.

Repeat steps 6 and 7 until all the values are correct.

Select the way you want your dates to appear—month-day-year, day-month-year, 
or year-month-day.

(SjjMM/DD/VV 
O DD/MM/VV 
O ¥ V/MM/DD

Make your selection by clicking in the button next to your choice.

10 Select a 12-hour or 24-hour clock.

® RM/PM
024 Hour

If you want a 12-hour clock, click in the button next to AM-PM.

If you want to, select Auto Daylight Savings by clicking in the box.

If you select this option, the computer will automatically make adjustments for Daylight 
Savings Time. Otherwise select Standard Time or Daylight Time by clicking in the 
appropriate circle.

When you’ve made your selections, put the Time Control Panel away by clicking 
the close box in its upper-left corner.

Leave the Control Panels window open for now if you want to make more changes. If not, 
click the close box in the upper left corner of the Control Panels window.
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Taking a break
You can take a break from this book whenever you like. If you expect to return in a short 
time, it’s fine to leave the computer on. But if you’re finished working for the day, you may 
want to turn it off.

If you plan to keep working now, you can move ahead to the next chapter and return 
to this page when you’re ready to stop.

Follow these steps to turn off your computer:

1 Choose Shut Down from the Special menu.

Special
Clean Up

Preferences...

Icon Info 61

Move the arrow pointer to the word Special in the menu bar. Press (hold 
down) the mouse button to display the menu. Drag the pointer down 
the menu until Shut Down is highlighted. Release the mouse button.

Shut Down... f 6Q
¥

A Important Be sure to use the Shut Down command instead of simply switching off the 
computer. The Shut Down command keeps your desktop in proper order—protecting your 
documents and application programs. A

You see this screen.

PSEtUSP 00CDE 00GS0DS

@ Shut Down (turn off system power)
ORestart
O Quit to previous application

( Cancel ~)C OK ])

The Shut Down option is already selected. If you change your mind about shutting down 
at this point, clicking Cancel returns you to the Finder.
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2 Click OK.

The computer ejects any disks in your 3-5-inch disk drives, and you see a message letting 
you know that it’s safe to switch off the power.

If you change your mind about shutting down after you’ve clicked OK, just click the Restart 
button on the screen. The computer starts up again. (If you start up from floppy disks, be 
sure to insert your disk before you click the Restart button.)

3 Switch off the computer and the monitor.

When you’re ready to start again, turn to Chapter 4 to learn about your computer disks.
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4 Preparing and Using Computer Disks

This chapter teaches you about the various types of disks you can use with your computer.

You’ll learn how to tell them apart, how to insert them and eject them, and how to get them 

ready to store your information. You’ll also learn how to look at the contents of your disks.

A Important If you have a hard disk, you should initialize it and install system software to 
make it your startup disk before you go through the exercises in Chapter 4 through 
Chapter 8. Because the instructions are written with System.Disk as the startup disk, you'll 
need to slightly modify the steps. For example, while floppy disk users see the System.Disk 
icon containing a System folder, you see your hard disk icon containing a System folder. A



Preparing disks for use
In this section you’ll learn about floppy disks and hard disks, and about the capacities of 
the disks you use with your computer. You’ll also learn the proper way to insert and eject 
disks, prepare them for storing information, and protect their contents. Finally, you’ll learn 
about startup disks, and how they differ from other disks.

Understanding floppy and hard disks

Both floppy and hard disks store information so you and your computer can have access to 
that information.

Floppy disks can be inserted into and ejected from a floppy disk drive, which is 
connected by a cable to the computer. Hard disks are generally sealed inside a peripheral 
device and are also connected by a cable to the computer. Both hard disks and floppy disks 
show up as icons on your desktop. You look at, work with, and add to the information on 
both kinds of disks in exactly the same way.

The major difference between hard and floppy disks is their capacity—the amount of 
information they can hold. In addition, hard drives generally use fixed media while floppy 
drives hold removable media.

The basic unit for measuring information is the byte. A byte, like an ounce or a second, is 
a very small unit, and not convenient for describing how much information fits on a disk. 
Disk capacity is typically measured in two larger units:

■ A kilobyte is 1024 bytes, and is represented by the abbreviation KB—or just K.

■ A megabyte is 1024 kilobytes, and is represented by the abbreviation MB.

A convenient rule of thumb is that an average full page of text takes up roughly four 
kilobytes (4K) of disk space.
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Figure 4-1 Types of 3.5-inch floppy disks

Distinguishing the types of floppy disks

The two most common types of 3.5-inch floppy disks are 800K disks and 1.4 MB high- 
density (HD) disks.

Both 800K and 1.4 MB floppy disks are physically the same size, and the differences 
between them are subtle. Figure 4-1 shows how you can tell them apart. Floppy disks are 
sometimes available in different colors, but the colors don’t correspond in any way to disk 
capacity.

Look at the floppy disks that came with your computer. By comparing them with the 
illustration, you should be able to tell that all of them have an 800K capacity.

Even though they don’t come with your computer, you may also encounter 5.25-inch 
floppy disks. Besides being larger than 3.5-inch floppy disks, they are flexible—not housed 
in a hard plastic case.

Inserting a disk into a disk drive

It’s important to know which type of disk you’re working with, because not all types can be 
used in all floppy disk drives

As the chart in Figure 4-2 shows, a floppy disk drive can take disks of the corresponding 
capacity, plus any smaller-capacity disks. Thus, a 1.4 MB disk drive can take both 1.4 MB and 
800K disks. But larger-capacity disks can’t be used in smaller-capacity drives; you can’t use
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Compatible DisksDisk Drive Model

Figure 4-2 Compatibility of various floppy disks

a 1.4 MB disk in an 800K drive. (If you have purchased an Apple SuperDrive and an Apple 
3.5 Disk Controller Card, you can use 1.4MB disks. However, remember that Apple 3.5 
Drives are 800K drives.).

The procedure for inserting a 3.5-inch floppy disk into a disk drive is the same no matter 
what kind of disk or drive you are using. As mentioned earlier in this guide, you always 
insert the disk metal end first, label side up. When the disk is most of the way into the disk 
drive, the computer pulls it in and into place.

(For information about how to insert a 5-25-inch floppy disk, see Chapter 4 of the Apple 
11gs System 6 User’s Reference.)

44 Chapter 4 Preparing and Using Computer Disks



Preparing a new disk for use

A blank disk is like a newly surfaced parking lot. Before the computer can begin to store 
information on a disk (“park the cars”), it has to mark off storage areas on the disk’s surface 
(“draw the divider lines”). This process is called initializing or formatting a disk.

Important If the only disks you have are the ones that Apple provided with your Apple 
IIgs computer, skip to Working with the Contents of a Disk,” on page 56 for now. You can 
come back to this section when you have a new blank floppy disk to prepare for use. A

If your computer isn’t on right now, start it up to the Finder.

See page 24 if you need to review instructions on starting up.

For the next step, you need a floppy disk. You can use either of the following:

■ a brand new floppy disk

■ a floppy disk whose contents you don’t need

2 Insert the floppy disk into the disk drive.
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■ If you inserted a brand new floppy disk, in a few moments you see a message asking 
whether you want to initialize it (prepare it for use).

▲ Warning Initializing the disk will erase its contents, a

■ If you inserted a floppy disk that’s been used before, in a few moments you see the disk 
icon appear on the desktop. To erase the disk so you can reuse it, skip to “Erasing a disk 
so you can reuse it,” on page 49. If the disk has been used with a different file system, 
you’ll see a message asking whether you want to initialize it; continue in this section.

GS/OS can't read this disk (in device .flPPLEDISK3.5B). Da 
\ you want to initialize it?

(Eject!) (Initialize)

Click Initialize.

Or, if you change your mind about initializing the disk, click Eject.

When you click Initialize, you see a dialog box with a space for you to type the name of the 
disk.

Type this name for the disk: Test. Disk.
You use the name Test.Disk only for the purposes of this exercise. You could actually type 
any name that conforms to the following guidelines:

■ Start the name with a letter.

■ Use no more than 15 characters.

■ Don’t use spaces.

■ Don’t use characters other than letters, numbers, or periods.

■ Make sure no two disk icons on the desktop have the same name.

The window on the left lists the file systems available on the startup disk. (For now you’re 
using the ProDOS® file system. When you’re ready to learn about other file systems, see 
the Apple I1GS System 6 User's Reference.)
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The window on the right shows disk formats or disk sizes, depending on the type of disk 
you’re trying to initialize.

If necessary, select a file system and a disk format.

If you’re initializing an 800K disk in an Apple 3.5 Drive, you’re given a choice of two formats: 
800K 2:1 and 800K 4:1. The 2:1 and 4:1 labels refer to different ways to format the disk.

■ If you’ll be using the disk in both Apple 3-5 Drives and UniDisk 3-5-inch drives, accept 
the highlighted option, 800K 2:1.

■ If you’ll be using the disk primarily in a UniDisk drive, select the 800K 4:1 option by 
clicking it once.

♦ By the way UniDisk drives are white, and Apple 3.5 Drives are platinum (the same 
color as the computer). Each type of drive is also identified on its underside. ♦

Click Initialize.
When the disk is initialized, the disk icon appears on the desktop with the Test.Disk name.

Renaming a disk

You can name any disk whatever you like, as long the name follows the guidelines on 
page 46 in the previous section.

To practice renaming a disk, you can use the Test.Disk you just initialized.

Important Don’t change the name of the Install, System.Disk, or any other disks that 
came with your computer. If the only disks you have are the ones that Apple provided with 
your Apple IlGS computer, skip to “Working with the Contents of a Disk,” on page 56 for 
now. You can come back to this section when you have a new, blank floppy disk to prepare 
for use. A
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Follow these steps:

If it isn’t already highlighted, click the Test.Disk icon to select it.

Here’s how: Move the tip of the arrow pointer over the disk icon and click the mouse 
button once. The disk and its name become highlighted.

St 
imam

II Hill IH

Test.Disk

A Important If you accidentally move the icon while you’re selecting it, you have to click 
somewhere else on the desktop to deselect it; then click the icon again. Otherwise, you 
won’t be able to rename the icon. A

2 Type Practice.Disk.

Keep in mind that you could actually type any name you like, as long as it conforms to the 
naming guidelines starting on page 46. However, for the purposes of this exercise, use 
Practice.Disk.

Pr(

As you type the first new character, the old name disappears. A blinking insertion bar 
indicates where each successive character will appear.

■ You can use the Shift key to type uppercase letters, as you would with a typewriter.

■ If you make a mistake while typing, use the Delete key to erase characters to the left of 
the blinking line.

j When you’re finished typing, press the Return key.

Pressing the Return key saves the new name.
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Important Press the Return key to save the new name, otherwise the disk name will 
revert to its original name. A

Erasing a disk so you can reuse it

If you have just initialized a new disk, read through these instructions, but don’t actually do 
them until later—when you have a disk that contains material you no longer need.

A Important If the only disks you have are the ones that Apple provided with your Apple 
IlGS computer, skip to “Working with the Contents of a Disk," on page 56 for now. You can 
come back to this section when you have a disk you want to erase. A

Follow these steps to erase a disk:

1 Insert the disk you want to erase in an empty disk drive.

2 Select the disk icon by clicking it once.

Choose Erase from the Disk menu.

You see this screen.

Disk 
Initialize...
Erase... h
Verify

Eject 4E

This operation will destroy all of the 
/■ \ information on this disk.

( Cancel ) ( Erase ]
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Type a new name for the disk.

For the purpose of these exercises, type Practice. Disk.

You could actually name the disk anything you like, as long as the name conforms to the 
guidelines listed in “Preparing a new disk for use,” on page 45.

Click Erase.

When the disk is erased, the disk’s name changes to Practice.Disk.

Ejecting a disk from a disk drive

You eject a floppy disk from a disk drive when:

■ You’re finished working with it.

■ You need to use a different floppy disk, and you have only one disk drive.

■ You want to lock or unlock the disk (described in the next section of this chapter).

In the following you eject the disk you just initialized (or erased).

Drag the disk icon to the Trash.

Make sure the tip of the arrow moves to the Trash icon, and the Trash 
icon becomes highlighted.

♦ Note Dragging a disk icon to the Trash doesn’t do anything to the contents of that disk. 
The contents of the disk are perfectly safe. All that happens is that the computer ejects the 
disk, and its icon disappears from the desktop. ♦

Release the mouse button.

The disk is ejected from the disk drive and its icon disappears from the desktop.
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Locked Unlocked

Figure 4-3 A locked and unlocked disk

Locking a disk to protect its contents

When a disk is locked, or write-protected, you can read the information on it but you 
can’t add, change, or delete information. You might want to lock a disk to prevent someone 
else (or yourself) from accidentally making changes to it. Figure 4-3 shows a locked and 
unlocked disk.

The following steps explain how to lock and unlock disks:

Find the locking tab on the disk you just ejected from the disk drive.

If you hold the disk so that you can read its label, the locking tab is in the upper-right corner.

To lock the disk, turn the disk over and slide the tab toward the outer edge of the 
disk.

It’s often easiest to do this using your fingernail.

Locking the disk uncovers a small hole.
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To unlock the disk, slide the tab to its previous position (covering the hole).

You can lock and unlock any floppy disk in this way as often as needed.

Take time now to lock all the disks that came with your computer.

Making back-up copies of your disks

It’s important that you make a backup copy of any disk that contains material that you want 
to protect. At the very least, be sure to make copies of the disks that came with your 
computer. You should also make copies of the applications that you purchase to use with 
your computer, as well as any disks that contain information you don’t want to lose.

Important Most application programs are protected by copyright; it’s illegal to copy them 
(except to make a backup copy for your own use). Some software manufacturers copy­
protect their disks to prevent illegal copying. If you have a copy-protected program, the 
manufacturer generally provides one backup copy or offers replacement of damaged disks 
at a nominal cost. A

Making a back-up copy of your system disk

In this section, you make a backup copy of the System.Disk. Because it’s the disk you’re 
copying, it’s called the source disk. Make sure that it’s locked so that you won’t 
inadvertently erase the material it contains. (For instructions see “Locking a disk to protect 
its contents,” on page 51 in the previous section.) You need another disk to receive the 
copy; it’s called the destination disk. This disk can be either of the following:

■ a blank, unformatted disk (To initialize it, follow the steps in “Preparing a new disk for 
use,” on page 45, to initialize it.)

■ a disk that contains material you don’t need any more (The material will be completely 
replaced by the contents of the source disk.)

In either case, name the disk Sy stem, backup.

Don’t use Practice.Disk; you’ll use it for later exercises.
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If you’re using only one floppy disk and a hard disk drive, turn to “Copying with one floppy 
disk drive and a hard disk,” on page 88, for instructions on how to make backup copies of 
your disks.

If you’re using two floppy disk drives, follow these steps:

Insert both the System.Disk and the System.backup disk.

The icons of both disks must be displayed on the desktop.

If you have only one 3-5-inch disk drive, follow these steps:

■ Insert the source disk, System.Disk.

■ Eject the source disk manually by pressing the eject button. (You can also select the 
icon and choose Eject from the File menu.)

■ Insert the destination disk, System.backup.

Drag the System.Disk icon on top of the System.backup disk icon.

s 
ehhemss

You see a message asking you if you want to replace everything on the destination disk with 
what’s on System.Disk.

▲ Warning Copying a disk erases everything on the destination disk and replaces it with the 
contents of the source disk. Before you continue, be sure that the destination disk doesn’t 
contain any information you need. A

Click Replace.

If you’re using only one disk drive for the copying procedure, you see a message whenever 
it’s necessary to swap disks. Follow the directions on the screen.

When the copying procedure is complete, you’ll have a backup copy of the information on 
System.Disk.
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t Eject System.backup by dragging its icon to the Trash.

Put System.backup away for safekeeping.

In the next exercise, you learn to make a backup copy of the other disks that came with your 
computer—a process slightly different from making a copy of the system disk.

Making a back-up copy of non-system disks

In this section, you make a backup copy oi Systemidols 1. Make sure that it’s locked and then 
prepare another disk to receive the copy. As in the previous exercise, you can use a blank, 
unformatted disk, or a used disk that you no longer need. In either case, name the disk 
STI. backup.

If you’re using only one floppy disk and a hard disk drive, turn to “Copying with one floppy 
disk drive and a hard disk” on page 85, for instructions on how to make backup copies of 
your disks.

If you’re using two floppy disk drives, follow these steps:

1 With System.Disk inserted in your startup drive, insert STl.backup, the 
destination disk, in your second drive.

If you have only one 3-5-inch disk drive, follow these steps:

■ Using the button on the disk drive, eject System.Disk.

■ Insert STl.backup.

With only one drive, the copying process will require many disk swaps. Follow directions 
on the screen.

1 When you see the STl.backup icon on your screen, eject the disk by using the 
button on your disk drive.

When you eject the disk manually, you still see its shadow on your screen.

3 Insert SystemToolsl, the source disk, in your second drive.
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t Drag the SystemToolsl icon on top of the STI.backup icon shadow.

You see a message asking you if you want to replace everything on the destination disk with 
what’s on SystemToolsl.

▲ Warning Copying a disk erases everything on the destination disk and replaces it with the 
contents of the source disk. Before you continue, be sure that the destination disk doesn’t 
contain any information you need. ▲

5 Click Replace.

You see a message whenever it’s necessary to swap disks. Follow the directions on the 
screen.

When the copying procedure is complete, you'll have a backup copy of the information on 
SystemToolsl.

Eject STI.backup by dragging its icon to the Trash.

Put STI.backup away for safekeeping.

Take time now to make backup copies of all the other disks that came with your computer.

A Important Should you ever need your backup copies, rename them with their original 
names before using them. When you add System 6 features to your disks, the Installer 
program looks for the original disk names. A

Understanding startup disks

Aside from capacity, there is another important way of distinguishing disks: some disks can 
be used to start up the computer, while others are used only to store information.

A disk you can use to start up the computer is called a startup disk. A startup disk 
contains software that your computer can use to start itself up. This special software is in a 
folder called the System folder. For example, the System.Disk is a startup disk because it 
contains the necessary startup files within its System folder. You can make any floppy or 
hard disk a startup disk by installing the proper startup files on it.
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If you try to start your computer with a floppy disk that doesn’t contain a startup file, 
the computer informs you that the disk is not a startup disk and ejects that disk so you can 
insert a startup disk in its place.

For more information about startup disks (such as how to create one), see Chapter 2 in 
the Apple IIgs System 6 User’s Reference.

Working with the Contents of a Disk
You’ve probably had the experience of going to visit someone in an office building, and 
arriving without knowing exactly where his or her office was. You may have found out by 
checking the building directory—the list of people who work in that building, plus the room 
numbers of their offices.

The items on a disk are also presented in a directory. This section explains how to work 
with disk directories.

In the next exercise you will use two different methods for opening disk and folder icons:

■ Highlighting the icon and then selecting Open from the File menu.

■ Double-clicking the icon to open it.

Seeing what’s on a disk or in a folder

You remember that telling your computer what you want to do is generally a two-step 
process:

■ First you identify the object you want to work with by selecting it.

■ Then you choose a menu command to perform an action on that object.

You can also open a disk or a folder by following this two-step process. Follow these steps 
to see what’s on a disk or in a folder:

1 To see the directory for System.Disk, click the icon once to select it.

The icon becomes black to indicate that it is selected.
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Choose the Open Command from the File menu.

The disk icon opens into a window.

There may not be very much in the disk—perhaps just a folder or two. But each folder also 
has its own contents.

Seeing the contents of a folder works the same way (double-clicking is the shortcut).

Double-click the System folder icon to see the contents of the folder.

(If nothing happens, you may need to double-click faster.)

You’ve opened the window for the System folder on System.Disk.

As you can see, it contains many more icons. These icons are important to the operation of 
your computer, but right now you don’t need to be concerned about what they do.

Close the System folder window now by clicking its close box.

The folder directory will collapse into its folder icon.

Remember there are two ways to open an icon:

■ Click the icon to select it, and then choose Open from the File menu.

■ Double-click the icon.

Both of these techniques work for all disk, folder, application, and document icons, as well 
as for the Trash.
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Closing a window

You already know one way to close a window: Click its close box.

Here’s another way: Choose the Close command from the File menu. The window closes, 
exactly the same way it would if you had clicked its close box.

Now you know two ways to close a window:

■ Click the close box.

■ Choose Close from the File menu.

Both of these techniques work for all disk, folder, program, and document windows, as well 
as for the Trash.

Moving a window

You can move a window by dragging its title bar—the lined bar at the top of the window. Try 
the following steps with your open System.Disk directory window.

Position the pointer anywhere on the title bar (except over the close or zoom 
boxes).

—1 1 ...... . ...... ....... Curt am H i r L —£ =i31 =

ProDOS 4 items 7U2K used 58K free

ProSoS System Icons
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Drag the window by pressing and holding down the mouse button and then 
moving the mouse.

A dotted outline of the window follows your movements.

Release the mouse button.

The window moves to the new location you’ve chosen.

Practice dragging the window around on the screen. You can’t drag it completely off the 
screen and lose it—try it and see.

Selecting a window to work in

Just as you can have more than one piece of paper on your desk at a time, you can have 
more than one window open on your desktop at a time.

When you have several papers on your desk, you select the one you want to work with 
by moving it on top of the others so you can see it. In the same way, when you have several 
windows open on your desktop, you select the one you want to work with by moving it “in 
front of” the others.

Selecting a window is called activating a window, and the window you select becomes 
the active, and frontmost, window. There are a couple of ways to do it; you practice both 
of them in this section.
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Start by opening your System folder window again now. (Use whichever method of opening 
windows you prefer.)

If you can no longer see the System. Disk window at all, drag the System folder 
window by its title bar until you can see part of the disk window behind it.

You need to do this only if the System folder window completely hides the disk window 
from view.

Click anywhere in the System.Disk window to move it in front of the System 
folder window.

Notice that you can now see the entire disk window on the desktop.

Also notice the lines in the title bar at the top of the window. The lines mean that the 
window is active. (Just as a highlighted icon is black, an active window has lines across the 
top.)
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Now click anywhere in the System folder window to move it in front of the 
System.Disk window again.

Notice that windows don’t move to a different location on the screen when they become 
active or inactive. They simply move “in front of” or “behind” other windows. Sometimes 
when you think you’ve lost a window, it has simply moved behind a larger window that 
hides it from view.

Now try another way to activate a window:

Positioning the pointer over the Windows menu, press (hold down) the mouse 
button to see the menu.

You see the names of both open windows, with a check mark next to System folder, 
indicating that it is the active window.

2 Drag the pointer down until System.Disk is highlighted.

3 Without moving the mouse, release the mouse button.

The System.Disk window becomes active.

Using the Windows menu to activate windows is particularly helpful when an entire window 
is hidden under another window, or when you have many windows open at the same time.
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Changing the size of a window

You may want to make a window as large as the screen so you can work in it easily or as small 
as a matchbox so you can get it out of the way, but still see some of its contents.

If your System folder window is still open, you can experiment with it in the steps that 
follow, but any window will do.

Click the zoom box—the tiny box inside the square in the right corner of the title 
bar.

15K free
The window zooms out to nearly fill the screen

Click the zoom box again.

The window returns to its former size.

The zoom box, as its name suggests, provides a fast way to resize a window. But it doesn’t 
allow you to fine-tune the window’s size or shape. The fine-tuning control is the size box 
in the lower-right corner of the window.

To fine-tune the size of a window:

If you can’t see the size box right now, move the window (by dragging its title 
bar) until it appears.

Position the pointer on the size box, press the mouse button, and drag up and to 
the left.
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As you drag, a dotted outline of the window follows. If you continue pressing the mouse 
button and watch the screen as you drag up, down, left, and right, you can see the outline 
follow your movements.

Release the mouse button.

The window changes size to match the outline.

If you don’t like the new size, drag the size box until you do.

Notice that the contents of a window don’t change when you change a window’s size. All 
that changes is the area you can see.

Seeing hidden parts of a directory or document

Sometimes there’s more in a directory or document than you can see in a window at one 
time. You just saw that you can make the window as large as the screen. But sometimes even 
that doesn’t provide enough room for you to see everything a directory or document 
contains.

Imagine that your house has one window on the wall facing your neighbor’s house. If it 
were an ordinary window, its position would be fixed, and you would shift your view by 
moving to look through it at different angles. But the windows on your computer are 
unusual windows, because you use them by standing in the same place and moving the 
window itself up, down, or sideways.

A computer window is like a moveable window in a wall. Through the window you can 
see part of your disk contents, or document, or whatever you happen to be working on. 
The scroll bars are the controls that allow you to move the window to see a different part 
of your disk contents or document.
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Figure 4-4 Viewing information through computer windows

If you’re working in a disk window or document that fits horizontally in the window, the 
horizontal scroll bar will be white (meaning that there is nothing more to see on either the 
left or the right side of the window). However, the vertical scroll bar may be gray, meaning 
that there is more to see than can fit vertically in the window.

If one or both of the scroll bars on your System folder window are white, use the size box 
to shrink the window until both scroll bars are gray.
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Practice using the scroll bars to see the hidden sections of the System folder directory. 
Remember that you’re “moving” the window, not the directory.

To move to the top or bottom of the directory you can do any one of the following:

■ Click the scroll arrow pointing up or down.

■ Click the gray part of the scroll bar above or below the scroll box.

■ Drag the scroll box up or down.

To move to the left or right side of the directory you can do any one of the following:

■ Click the scroll arrow pointing left or right.

■ Click the gray part of the scroll bar to the left or right of the scroll box.

■ Drag the scroll box left or right.

You’re now ready to go on to Chapter 5, where you’ll learn about using software programs.
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5 Using Application Programs

This chapter tells you about application software, the programs that you use to perform 

specific tasks with your computer. Now that you have learned about the basic skills you 

need to use your Apple IIgs, you’re ready to start using such programs. You’ll be using 

application programs to create all kinds of documents with your computer. Although each 

program is different, this chapter provides you with enough information to familiarize you 

with their typical features.



Understanding application programs
In some ways, buying a computer system is like buying a stereo system. A stereo system 
consists of individual components that may include an amplifier, tape deck, turntable, 
compact disc player, and speakers. The stereo system doesn’t do much by itself, you buy a 
stereo system because you want to play compact discs or listen to the radio.

A computer system also consists of individual components—the computer itself, a 
monitor, probably a separate disk drive or printer, and so on.

Like the stereo system, the computer system doesn’t do much by itself. You buy a 
computer because you want to use software programs to manage your business, track your 
finances, do school work, or write letters or a book.

One of the greatest advantages of using an Apple IIGS computer is that most Apple IIgs 
programs—also called application programs or applications—are designed to look and 
work in similar ways. In all new programs designed for the Apple IIgs, you click icons, 
choose commands from menus, and use windows that work the same way as the windows 
you learned about earlier. But keep in mind that if you have a detailed question about the 
way a specific program works, you should consult the manual that came with that program.

Your computer comes with a sample word processing program called Teach, which is 
on the floppy disk labeled SystemTools2. The rest of this chapter explains how to create, 
edit, save, and close a document using the Teach program. You do these basic tasks in 
essentially the same way in almost all Apple IIgs programs.

A Important The procedures that follow assume that you have two disk drives connected 
to your computer, either a floppy and a hard disk or two floppy disk drives. If you have only 
one floppy disk drive you will be prompted to change disks more frequently than 
documented and you may be prompted to perform additional steps not described in this 
manual. A
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Copying application programs
When you use application programs it is sometimes easier to have the program on the same 
disk as the documents. This reduces or eliminates the need to swap disks during your work 
session.

Before you create your first document follow the steps below to copy the Teach program to 
the disk you worked with in Chapter 4.

1 Using the button on your disk drive, eject System.Disk from your startup drive.

2 Insert SystemTools2 in your startup drive.

When you see the SystemTools2 icon on your desktop, double-click it to see the directory 
window.

SystemTools2 is the source disk because it contains the document you’re copying.

3 Insert Practice.Disk in your second drive.

Practice.Disk is the destination disk.

4 Drag the Teach icon from the SystemTools2 window to the Practice.Disk icon.

Here’s how:

1. Position the arrow pointer over the Teach icon.

2. Press (hold down) the mouse button.

3. Drag the Teach icon to the Practice.Disk icon.

4. When the destination disk icon becomes highlighted, let go of the mouse button.

The copying procedure, which places a copy of Teach onto the destination disk, will require 
disk swaps. Follow the instructions on the screen. A status box appears briefly on the screen 
while copying is in progress.

Notice that you didn’t remove Teach from SystemTools2 when you dragged it to the 
destination disk. Whenever you drag an icon from one disk to another, you copy that icon 
(and whatever it represents) onto the second disk. The original stays where it was.
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If you open the Practice. Disk icon now, the Teach icon appears in its directory window. Try 
it and see.

=11 - - - - - - Practice.Disk- - - - - - - ---------------- Hl=
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Teach

_ _ _ _ _ _ _ _ _ _ Kt Ip"]

You can leave the destination disk window open for now.

Eject SystemTools2 by dragging its icon to the Trash, then reinsert System.Disk.

Creating a new document
To create a new document, you open the application you want to use to create that 
document. For example, if you want to write a letter, you open your word processing 
application; if you want to draw a picture, you open your graphics application.

When you open an application icon, you are typically presented with an empty 
document window that usually has the name Untitled in the title bar. (You’ll name the 
document later, when you save it.)

You can think of this empty document window as a blank piece of typing paper, a blank 
piece of drawing paper, or whatever is appropriate to the application you’re using.

Whenever-you have a document window of any kind open on your screen, you are 
working in an application program; you are no longer in the Finder. This means you can do 
all the tasks associated with that application, but for the moment you can’t do desktop tasks 
such as renaming disks or looking at their contents.
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Follow these steps to create a new document:

Find the Teach icon in the Practice.Disk directory window and open it.

You can either double-click the icon, or click the icon once to select it and then choose 
Open from the File menu. Use whichever method of opening icons you prefer. You see the 
Finder go away and, in a few seconds, you see an empty Teach document window.

Teach

Notice that this Teach document window has the same features (such as the boxes for 
changing the sizes of windows) that you saw in directory windows in Chapter 4.

Also notice that Teach (like all programs) has its own set of menus. Some of the commands 
in these menus are different from the corresponding menus on the Finder desktop—more 
appropriate for the work you do in a word-processing program.

Look at the commands in the File and Edit menus.

Just press the menu titles to see the commands. Don’t choose any commands right now.
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Most applications you use with your computer have many of these same commands. You 
see the New, Open, Copy, Cut, and Paste commands in nearly every application you use.

When you click in the Untitled window, you see a line in the upper-left corner. This line is 
called the insertion point because it marks the place where text you type will be inserted. 
As you begin to type, keep these hints in mind:

■ You can use the Shift key to type capital letters, as you would on a typewriter.

■ If you make a mistake while typing, use the Delete key to erase characters to the left of 
the insertion point. You can move up, down, or across characters without erasing them 
by using the arrow keys.

■ Don’t press the Return key when you get to the end of a line—just keep typing. Teach 
(and almost any other word-processing program) automatically moves down to the next 
line for you when you run out of room on the line. This is called word wrap.

Now type this paragraph:

Because everyone has been arriving late for the Library 
Club meeting, we're trying a new policy starting Monday. 
The first person who arrives after 4:30 gets the job of 
distributing late book notices.
Congratulations, there’s your first memo.

Saving a document
When you save a document, you are telling the computer to assign it a name and store it on 
a disk. (If you turned the computer off now without saving your memo, it would be lost.) 
Saving also creates an icon for that document.

To save your memo, choose Save from the File menu.

The box that appears on the screen is called a dialog box. When the application program 
needs more information from you, it presents a dialog box. You provide the necessary 
information by clicking buttons and, in some dialog boxes, typing in the spaces provided.

This particular dialog box, called a directory dialog box, allows you to name your 
document and to store it in any folder or disk you please.
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File
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S3® Practice.Disk (ProDOS)

For now, you just want to keep things simple and store your document on the disk you 
prepared in Chapter 3.

Type CiubMemo in the text box.

The box is already highlighted for you, so all you have to do is start typing.

Click the Save button.

Your document, with the name you just gave it, is saved on the disk. You can now see the 
document’s name in the title bar of the window.

Choose Quit from the File menu.

File
New 6N
Open... 60
Import file...
Save AS
Save as...
Save Copy as...
Close 6W

Page Setup...
Print... 6P

Quitting takes you out of the Teach program and back to the desktop. 
You should be able to see the CiubMemo document icon in the 
Practice.Disk directory window, provided you are using two disk drives.
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Opening an existing document
Once you have created and saved a document, you can open it again simply by opening its 
icon. Opening a document also opens the program you used to create that document. You 
don’t usually need to open the program first.

The first time you open an application via one of its documents, you will be prompted 
to locate the application. Unless your startup disk is locked, the system will then record the 
location of the application and automatically locate it every time you double-click one of its 
documents.

ClubMemo
Try opening a document now: Double-click the ClubMemo icon.

A dialog box appears, telling you that the application for the document can’t be found. 
Follow these steps to locate Teach:

■ Click Locate.

■ In the dialog box, click Volumes to see a list of all the disks you have available.

■ Double-click Practice.Disk (or click it once and then click Open).

■ Click Open (Teach is already selected).

The Teach application opens, with the ClubMemo file open on the screen.

ClubMemo
Because everyone has been arriving late for the Library Club meetings, we’re 
trying a new policy startingJMonday. The first person who arrives after 4:30 
gets the job of distributing late book notices.

A Important Not all application programs allow you to open them by double-clicking a 
document. You may have to double-click the application icon to open the program, and 
then choose Open from the application’s File menu to open your document. A
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Editing your work
Now you’ll make some changes to your memo. When you edit text, remember that the 
blinking line marks the insertion point on the screen. Just as you move the arrow pointer 
on your desktop and select an icon by pointing and clicking, you move the text pointer and 
select the place you want to edit by pointing and clicking. You can also use the arrow keys 
to move the text pointer to the place where you want to insert or delete text.

The text pointer is called an I-beam, and looks like this:

Here’s how to add a word to a sentence:

1 Position the I-beam just before the letter M in the word Monday. Then dick the 

mouse button once to place the insertion point there.

ClubMemo
Because everyone has been arriving late for the Library Club meeting, we're 
trying a new policy starting nextl Monday. The first person who arrives after 
>1:30 gets the job of distributing late book notices.

If you’re not comfortable with the mouse yet, take your time and don’t be discouraged if 
this seems difficult. You can keep positioning the I-beam and clicking until the insertion 
point is where you want it. (Don’t move the mouse while you click.)

Type next and then press the space bar once to put a space between next and 
Monday.

Notice that when you add text, the words following the new text move to make room for it, 
wrapping down to the next line if necessary.

ClubMemo
Because everyone has been arriving late for the Library Club meeting, we're 
trying a new policy starting nextl Monday. The first person who arrives after 
M:30 gets the job of distributing late book notices.
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Now you want to edit your first sentence so it won’t start with Because. You can do this by 
moving the phrase, “we’re trying a new policy starting next Monday” to the beginning of 
the sentence.

To move any piece of text, you first cut it from its old location and then paste it in a new 
one.

As you’ve done in other situations, you’re going to select what you want to work with and 
then choose a command.

Select the words we’re trying a new policy starting next Monday.

Here’s how:

1. Position the I-beam just to the left of the w in the word we’re.

2. Press (hold down) the mouse button.

You’ve now anchored yourself at the beginning of the text you want to select.

3. While holding down the mouse button, drag the mouse sideways and down until all the 
words you want to select are highlighted. Don’t highlight the period. Take your time. As 
long as you hold the mouse button down, you can move the mouse indefinitely without 
losing your anchor point. If you release the mouse button by mistake, reposition the I- 
beam and start again.

4. When the phrase is highlighted, let go of the mouse button.

ClubMemo
we're

new doHcm starting next Monday
Because everyone has been arriving late for the Library Club meeting.BITOI 

The first person who arrives after 
4:30 gets the job of distributing late book notices.

Cut the phrase you’ve selected by choosing Cut from the Edit menu.

The phrase disappears and the rest of the text is repositioned.

ClubMemo
(Because everyone has been arriving late for the Library Club meeting, The 
first person who arrives after 4:30 gets the job of distributing late book 
notices.
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Position the I-beam where you want to paste the phrase you just cut.

Move the I-beam to the beginning of your memo and click the mouse button. 

The insertion point moves to the beginning of the memo.

Choose Paste from the Edit menu.

The text reappears in the new location. Now your memo looks something like the following 
illustration.

Edit
&!<!<!

Cut
Cupp 4C
Paste I 6V
Chiur

ClubMemo
we're trying a new policy starting next Monday.Because everyone has been 
arriving late for the Library Club meeting, The first person who arrives 
after 4:30 gets the job of distributing late book notices.

Fix the capitalization, punctuation, and spacing in the sentence you just 
rearranged.

Here is the general procedure:

1. Position the I-beam to the right of any character or characters you want to change.

2. Click the mouse button to place the insertion point.

3. Press the Delete key to erase characters to the left of the insertion point.

4. Type the new characters.

Now you want to save the changes you’ve made to your document. So far the changes are 
in the computer’s memory, but if there were a power interruption right now your changes 
would be lost. The original version of the document is protected because you’ve already 
saved it on a disk.

Power interruptions are rare, but—as many people have discovered the hard way—they 
can destroy hours of work. You can protect your documents by saving them often.

File
New 6N
Open... (JO
Import file...
Sove p (IS
Save as...
Save Copy as...
Close 6W

Save your edited memo now by choosing Save from the File menu. This 
time you don’t see a directory dialog box when you choose Save. The 
computer simply saves any changes made to your document since the 
last time you saved, without changing either the name of the document 
or its location.
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By choosing Save often, you’ll never lose more than a few minutes of work if a power 
interruption occurs.

Putting a document away
You saw in an earlier section of this chapter that opening a document automatically opens 
the program that created it. However, closing a document does not automatically close 
the program. This is so you can continue working in that program if you want to, without 
returning to the desktop first.

You can see how this works by closing the memo you just saved. Choose Close from the 
File menu.

The memo disappears. What appears on the screen at this point looks something like 
the Finder desktop, but it isn’t.

File
New 6N
Open... ciO
Import file...
Save 6S
Save as...
Save Copy as...
Close p iiW

Page Setup...
Print... 6P

Quit 6Q

Three clues can help you figure out where you are:

■ There are no icons in sight. If you were back on the desktop, you’d see icons 
representing your floppy disk and the Trash, as well as any windows that were open 
when you began working.

■ The menu bar at the top of the screen contains the menu titles for the Teach program.

■ The first item in the Apple menu is About Teach. An “About” item describing the current 
application program always appears here.

The document you were working on is now closed, but the Teach program is still open. 
If you wanted to start a new Teach document, you could choose New from the File menu, 
and a new Untitled window would appear on the screen. (Don’t try this now.)
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But you’re finished working with Teach, so you want to go back to the desktop. The next 
section explains how.

Putting a program away
To close both a document and its associated program at the same time, choose the Quit 
command from the File menu.

You can also choose Quit if you find yourself in a program but not in any particular 
document—as you do now, after finishing the steps in the previous section.

You can see how this works by quitting the Teach program. Choose Quit from the File 
menu. In a moment you see the Finder desktop again. Then you can go on to Chapter 6 to 
learn about copying documents and disks.
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New ciN
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Import file...
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Save as...
Save Copy as...
Close 6W
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In summary, whenever you want to finish your work and go back to the Finder desktop, 
simply choose Save to save the latest changes to your document, and then choose Quit.

The Teach application contains other features that make it convenient to work with 
documents. For more information, see Chapter 6, “Working With Applications,” in the 
Apple I1GS System 6 User’s Reference.

For now, go on to Chapter 6, “Copying Documents and Disks," in this manual to learn how 
to make copies of your documents and disks.
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6 Copying Documents and Disks

You’ve learned how to save a document that you create with an application. This chapter 

explains how to make copies of documents and disks. As you work with your computer, 

you’ll find many uses for copying—to duplicate items, to move items from one disk to 

another, or to create different versions of documents.



Duplicating a document
While you’re working in a window on the desktop you may want to duplicate a document, 
perhaps so you can open and edit it without changing the original.

When you duplicate a document, you don’t have to open either the original document 
or the program you used to create it.

A Important The procedures that follow assume that you have two disk drives connected 
to your computer, either a floppy and a hard disk or two floppy drives. If you have only one 
floppy drive you will be prompted to change disks more frequently than documented and 
you may be prompted to perform additional steps not described in this manual. A

Follow these steps to duplicate your ClubMemo document.

Select the ClubMemo icon by clicking it once.

Choose Duplicate from the File menu.

A dialog box appears with a name already entered. The new name is followed by the 
number “2” because every icon in a disk or folder window must have a unique name—even 
if, as in this case, the icons represent identical objects.

File
New Folder 6N
Open 60
Print
Close 6W
Close Oil

Duplicate... [60
Put M 6 V
Writ idnta

Duplicating the item "ClubMemo".

New name: ClubMemo2

However, you’re going to give your memo another name instead of using ClubMemo2.

Rename the copy of the document by typing NewMemo and clicking OK.

You can move the NewMemo icon anywhere you like. For now, leave it visible in the disk 
directory window.
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You’ll be working with the NewMemo document in the next section of this chapter, so open 
its icon now. Use whichever method of opening icons you prefer.

NewMemo

NewMemo
I We' re trying a new policy starting next Monday. Because everyone has been 
arriving late for the Library Club meetings, the first person who arrives 
after gets the job of distributing late book notices.

You can see that the new document is exactly the same as the ClubMemo you duplicated to 
create it.

Saving different versions of a document
Sometimes you want to save different versions of a document. For example, you might want 
to create two versions of your resume that emphasize different job skills, or write three 
versions of a product brochure aimed at three different groups of customers.

Now you want to edit the NewMemo so you can send the revised version to a different 
group of your club members.

Make the following changes to the memo, using the editing techniques you 
learned in the last chapter.

■ Replace the word Library with the words Student Book.

■ Replace the words after 4:30 with late.

(For a review of general editing instructions, see page 75.)

If you were to save the memo now by choosing Save from the File menu, the new text you 
just added would replace the original text in the document called NewMemo.

But you want to save both the NewMemo, with its original wording, and your newly revised 
version of the memo.
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L Choose Save As from the File menu.

Save As allows you to save a revised document by giving it a different name, which is what 
you want to do next. When you choose Save As, a directory dialog box appears on your 
screen. As before, this box tells you where you are, and lets you indicate what you want to 
name your new memo and where you want to store it.

File
New 6N
Open... 60
Import file...
Save 6S
Saveas... \
Save Copy as...
Close 6W

Page Setup...
Print... 6P

Quit 6Q

Practice.Disk (ProDOS)

Type RevisedMemo in the text box.

The new name replaces the old name as soon as you begin typing.

You have just indicated that you want to save your revised memo with its new name— 
RevisedMemo—in the same directory and on the same disk as the original NewMemo. (This 
process has no effect on NewMemo.)

QlSl Practice.Disk (ProDOS) 
74N free of 8O0K.
□ CtobHesa

'koch

Save the file as:
RevisedMemol ( Cancel )
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n 
n Click the Save button.

Your memo is saved with its new name, which now appears in the title bar of the document 
window.

RevisedMemo
We're trying a new policy starting next Monday. Because everyone has been 
arriving late for the Student Book Club meetings, the first person who 
arrives late gets the job of distributing late book notices.

Choose Quit from the File menu.

Quitting takes you back to the desktop, where you see icons for all three documents in the 
disk directory window.
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Copying one or more items onto another disk
You’ll often want to copy an item from one disk to another, so you can:

■ protect your work by storing the copy (also called a backup) in a different place

■ give the disk to someone else who may want to work on the document

■ take the document to another location and work on it there

■ make your work more convenient by storing your application and your documents on 
the same disk

It’s important to back up your work regularly. A backup copy of a document is insurance 
against damage to the original. Taking a few seconds to back up a valuable document can 
save you much despair and many hours of extra work.

In Chapter 5, you used the SystemTools2 disk and Practice.Disk to practice copying an item 
onto another disk. You copied the Teach application.

If you want to copy additional items onto the destination disk, you could simply repeat the 
steps you followed to copy Teach for each icon you wanted to copy. Or you could select 
more than one item at once, and copy them at the same time.

Follow these steps to copy a couple of items at once:

1 If necessary, open the System.Disk icon to see its directory window.

You may need to drag the System.Disk window to a place on your screen that allows you to 
see part of the Practice.Disk window at the same time.

2 Find the ProDOS 8 and Basic.System icons in the System.Disk directory window.
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Hold down the Shift key with one hand while you click each of the icons with the 
other.

If you select the wrong icon, continue to hold down the Shift key and click that icon a 
second time to deselect it; then you can continue with your selection. When the icons you 
want are highlighted, let go of the mouse and release the Shift key.

Drag either of the selected icons to the Practice.Disk window.

Position the tip of the arrow pointer on either of the highlighted icons, press down the 
mouse button, and drag the icons together to any part of the destination disk window that 
you can see.

RevisedMemo ClubMemo

[flMjj System Icons

. . . . . . . .  Sustem.Disk =- - - - Eli 
ProDOS 4 items 7M6K used 55K free 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . E

A thermometer bar indicator will appear indicating the progress of copying the files to the 
Practice.Disk.

Click anywhere inside the destination disk window to activate it.

You see the icons you dragged there in step 3. You don’t need to keep the icons you just 
copied. Drag them to the Trash now to keep them from taking up space on your practice 
disk.

You can select and drag the icons to the Trash as a group, in exactly the same way that you 
just dragged them to your floppy disk. Or, if you prefer, you can drag the icons to the Trash 
one at a time.
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Copying with one floppy disk drive and a hard disk
Just as you copy valuable documents onto floppy disks for safekeeping, you can also copy 
entire floppy disks onto other floppy disks. This is done most commonly to make a backup 
copy of a disk.

The easiest way to copy disks depends on how many floppy disk drives you have. If you 
have two 3.5-inch floppy disk drives, you can look back at Chapter 4 for a reminder about 
how to make copies. If you have one floppy disk drive and a hard disk, follow the 
instructions in this section to make a copy of Practice.Disk. Before you begin, if you have 
a disk in your floppy drive, eject it now by dragging the disk icon to the Trash.

Copying one floppy disk onto another is a two-stage process, in which you use your hard 
disk as a temporary resting place for the information you want to copy.

■ First you copy the contents of the source disk onto your hard disk.

■ Then you copy that information from the hard disk onto the second floppy disk—the 
destination disk.

The following steps explain how:

1 Insert Practice.Disk into your floppy disk drive.

This is your source disk.

If your hard disk directory window is closed, open it again now.

3 Drag the source disk icon to the directory window of your hard disk.

6.6 MB free
Hard.Disk =- - - - - -

15 items 13.6 MB usedProDOS
Hard.Disk

.... J9
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You see a message telling you that the contents of your source disk will be placed in a folder 
in the directory window of your hard disk. This is because disk directories can contain 
folders, programs, and documents, but not other disks.

The two disks ore different sizes, so the contents of 
/1 \ "Practice.Disk" will be placed in a folder on "Hard.Disk".

(Cancel) ( OK j)

4 Click OK.

A status box indicates that copying is under way. When the box disappears, you see a folder 
icon with the name Practice.Disk in your disk directory window.

ProDOS 16 items 13.8 MB used 6.5 MB free

Eject the source disk (Practice.Disk) by dragging its icon to the Trash.

Insert the destination disk into your floppy disk drive.

If your destination disk is a blank, unformatted floppy disk, you must initialize it. If it's a 
ProDOS disk you’ve used before, be sure you don’t need its contents; they will be 
completely overwritten by the copying process.
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Drag the Practice.Disk folder from your hard disk directory window to the icon 
of the destination disk.

The folder and its contents are copied onto the destination disk.

=n Dest.Disk- - - - - - - - - - - - Pl=
ProDOS litem 72Kused 728Kfree

*

o
Practice.Disk

£1___________

8 Drag the Practice.Disk folder from your hard disk to the Trash.

16 items 13.8 MB used 6.5 MB freeProDOS

Dest.Disk

Applications liWMHWUmnBASIC. System

Wade.Project

IIIM

llllllllllllllllllllllllllllll
Hard.Disk

Icons Club.NewsletterProDOS System

Games

Be sure to remove the Practice.Disk folder; it takes up room on your hard disk that you 
could be using for other files.
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Important If you want your destination disk to be an identical copy of your source disk, 
with all the files in the same place as they were on the source disk, follow these steps:

1. Open the Practice.Disk folder on your destination disk

2. Select all the files by holding down the Shift key while you click each one.

3. Drag the selected files back to the destination disk icon shadow.

4. Drag the Practice.Disk folder—now empty—from the directory window to the Trash.

5. Close the directory window and reopen it to see an exact copy of the source disk 
contents. A

Now that you’ve learned how to copy documents and disks you may find it useful to 
organize your work. Go on to Chapter 7 to learn ways to organize your files.
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Organizing Your Work

As you work with your computer, you’ll accumulate more and more files that you’ll want to 

store so that you can retrieve them easily. This chapter shows you how to use folders to 

organize your files just as you would do in any file cabinet. It also explains how to find 

documents that you have stored, and how to throw them away when you’re finished with 

them.



Creating folders
As you acquire more programs and create more documents, you may want to organize your 
work on the desktop to make it easier to find what you need. The exact way you do this is 
up to you. But your basic organizational tool is the file folder.

Folders work the same way on your desktop as they do in your file cabinet. You decide 
how many folders you need, what they are called, and what they contain.

The layered arrangement you create by putting documents inside folders, and folders 
inside other folders, is called a hierarchy. In this chapter, you’ll see how to create and move 
around in a hierarchy of folders on a disk. As you work, keep in mind that “up” is toward 
your disk directory and “down” is deeper into the layers of folders you’ve created. You may 
also hear the term “root level,” which refers to the top layer, where no file or folder is inside 
another folder.

Startup 
Disk

J L?__

System 
Folder

Projects

Office
Memos Proposal Revised

Proposal
Royalty 
Work

Figure 7-1 Sample hierarchy of folders on a disk
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The right time to create a folder depends on your work habits.

■ If you like to organize your work in advance, you can create folders in windows on your 
desktop before you have anything to put in them, and then put each document in the 
appropriate folder as you create them.

■ If you prefer to fill your disk directory with documents and arrange them in folders later, 
you can do that too.

Here’s how to create a folder:

If necessary, insert your practice disk in a disk drive.

Open the Practice.Disk directory window.

Choose New Folder from the File menu.

A new folder named “Untitled” appears in the directory window.
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RevisedMemo Cl ubMemo

£11________ ____________ ■!!£

If you can’t see the entire folder, you can make the window larger or scroll down further in 
the window.

Rename the folder by typing Memos and then press Return.

Pressing Return saves the new folder name.
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Putting documents in folders
You can put just about anything in a folder: a document, an application, or another folder 
(except the System folder, which has to stay at the “top level" of the hierarchy).

You have three Teach documents in your disk directory window. You can see how the 
filing system works by putting these documents into the Memos folder you just created.

To put your documents into the Memos folder, drag each document icon to the folder 
icon. You can drag the icons one at a time, or you can select and drag them all at once. (See 
page 86 for instructions on selecting multiple icons.)

When you move an icon to another location on the same disk—for example, by putting 
it in a folder—the icon stays in its new location until you move it again.

In this case, your documents are still on the same disk, but they are no longer at the top 
level of the filing system. (In other words, you can’t see them in the disk directory.) By 
grouping the memos in their own folder, you’ve moved them one level farther down in the 
hierarchy.

If you open the Memos folder, you can see the three document icons. Try it. Then click 
the close box to close the folder. The next time you want to read, edit, or print one of these 
documents, open the Memos folder to find it.

Finding a document

When you have only a few documents on a disk, it’s easy to see where you’ve put them, so 
finding them isn’t a problem. But when you have hundreds of documents on a disk, as many 
people eventually do, finding the one you want can be more of a challenge.

There are several ways to locate a document on a disk. This chapter describes two of them:

■ Working in the Finder, you can open folders on the desktop. Some people manage fine 
with this method alone. It’s easiest if you give your documents meaningful names and 
file them logically.

■ Working in an application program, you can search in a directory dialog box. If you 
are working in a program, you can use directory dialog boxes to find any other 
document the program can open. You don’t need to return to the Finder desktop and 
start opening folders.
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♦ Note If you install the Find File desk accessory on your startup disk, you’ll have yet 
another method to keep track of files. Included with System 6, Find File allows you to 
search all current volumes for files that match, contain, start with, or end with the 
filename—or partial filename—that you specify. For information about how to install the 
Find File desk accessory, see Chapter 2 of the Apple IIgs System 6 User’s Reference. ♦

You can see how to find a document in a directory dialog box by using documents and 
folders you’ve already created.

The following two steps take you to the starting point of the search:

Open the Teach program on Practice.Disk.

You are now in the Teach application. You can tell because no icons appear on the desktop, 
the Teach menu titles are in the menu bar, and the Untitled document appears.

Teach

□ Untitled 1□

J

ft

Close the Untitled document window.

Let’s say that you want to find and open your NewMemo. Here’s what to do.
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J Choose Open from the File menu.

You’ve just told the computer that you want to open a document you’ve already created 
with that program. The computer responds by presenting a directory dialog box.

File |
New Folder 6H|
Open [, 60
hint
Close 6W
Close fill

Duplicate... 60
Put few
Validate

This directory dialog box lists the items in the disk directory to which you have access from 
within Teach. It doesn’t show you any items that you can’t open. In this case, all you see is 
your Memos folder.

Open the Memos folder.

You can double-click on or beside the folder name to open the folder. Or, you can click once 
on or beside the folder name to select it, and then click the Open button.

Now you’re looking at the contents of the Memos folder.

Please select file to open.
SJ-tjMemos (ProDOS)
□ ClubMemo
□ HewMemo
□ RevisedMemo

( Volumes )

C Open

( Close )
( Cancel )

While you’re here, click anywhere in the title of the Memos folder. The titles of the items 
you opened to get to this window appear in a pop-up menu. You can see at a glance how 
you got to the memos window. When you have many documents stored in many layers of 
folders, this feature makes it easy to keep track of where you are in the hierarchy.
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Open NewMemo.

You can double-click on or beside the document name to open the document. Or, you can 
click once on or beside the document name to select it, and then click the Open button.

The directory dialog box goes away and the NewMemo appears.

NewMemo
I We 're trying o new policy starting next Monday Because everyone has been 
arriving late for the Library Club meetings, the first person who arrives 
after >4:30 gets the job of distributing late book notices.

Choose Quit from the File menu to close your memo and return to the Finder 
desktop.

Throwing a document away

The right time to throw a document away, like the right time to create a folder, depends on 
your work habits.

You may like to keep copies of your work on disks indefinitely, or you may want (or 
need) to clear off space on a disk for new documents. If you need the space but want to 
keep a copy of the document, you can copy the file onto another disk that you store away 
in a safe place. If you have a hard disk, the Archiver application, included with System 6, 
provides protection against lost data. Refer to Chapter 8 in the Apple IIgs System 6 User’s 
Reference.
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To throw a document away, simply drag its icon to the Trash on your desktop. You can try 
this with your RevisedMemo icon.

Locate the icon you want to throw away.

In this case, you must open the Memos folder to see the RevisedMemo icon.

Drag the RevisedMemo icon to the Trash.

The document is “in the Trash" when the Trash icon becomes highlighted.

When you let go of the mouse button, the Trash icon “bulges” to let you 
know that there is something inside it.

♦ Note While the Trash usually works like a wastebasket, its behavior with disk icons is 
an exception. Dragging a disk to the Trash will never result in any loss of or damage to the 
information on that disk, it only ejects the disk. ♦

If you were certain you wanted to remove RevisedMemo from your disk, you could now 
choose Empty Trash from the Special menu. However, for the purpose of these exercises, 
don’t do that now. Instead, go on to the next section to learn about recovering items from 
the Trash. The chart summarizes what happens when you drag different kinds of icons to 
the Trash.

Table 7-1 Results of moving items to Trash

Type

Application

Document

Result

Application is removed from your disk and is no longer available.

Document is removed from your disk and is no longer available.

Floppy disk Floppy disk is ejected from the machine. No files are removed.

■■fiii'i Hard disk System will not allow you to throw away a hard disk.
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Recovering a document you’ve thrown away

Occasionally you throw away the wrong document by mistake, or change your mind about 
getting rid of a document you just dragged to the Trash. If you act promptly (that is, before 
turning the computer off, launching an application, or taking any other action) you can get 
the document back again. Although prompt action usually permits recovery, keep in mind 
that any time you drag an item to the Trash, you’re in danger of losing its contents.

Here’s how to recover your RevisedMemo:

Open the Trash icon.

The Trash opens into a window in which you can see your RevisedMemo.

Select your memo and choose Put Away from the File menu.

File
Hew Folder 6N
Open 60
Print
Close 6W
Close Oil

Duplicate... 60
Put Away . 6 V
Validate *

If you prefer, you could also drag the document icon back into the folder 
it came from, or to a different location.

Click the close box to put the Trash window away.

You’re now ready to go on to Chapter 8, where you'll learn how to print your documents.
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8 Printing Your Work

To follow along in this chapter, you’ll need to set up your printer if you haven’t already done 

so. The instructions in the manual that came with the printer explain how to unpack it and 

connect it to your computer. Chapter 9, “Connecting Additional Devices,” starting on 

page 109, also provides connection information.

If you don’t have a printer, you can skip this chapter.

If your computer is not connected to a network, turn the page and begin with the section 

“Telling the computer about the printer.”

If your computer is connected to a network, refer to Chapter 9 of this guide and to Chapter 

12 of the Apple IIgs System 6 User’s Reference for information about how to connect your 

printer and identify it for your computer. Then turn to “Printing a document,” on page 106.



Telling the computer about the printer
After you connect your printer, use the Installer program to add a printer update to your 
startup disk. If you have room on your startup disk, you may also want to install font 
updates. For information on adding such updates, see Chapter 2 of the Apple IIgs System 6 
User’s Reference.

♦ Note If you are using an 800K startup disk, you will not have room to install fonts. 
Shaston 8, built into your computer, is the font you’ll use for printing. ♦

Before you use your printer for the first time, you must tell the computer what type of 
printer you have and which port it’s connected to. You provide this information in the DC 
Printer Control Panel.

First, make sure that your computer and the printer are both turned on.

Then follow these steps:

Choose Control Panels from the Apple menu.

The Control Panels window opens.
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Find and open the DC Printer Control Panel icon.

DC Printer

You may have to scroll to find it.

Remember that you can open the icon by clicking it once and then 
clicking the Open button, or by double-clicking the icon.

Select a port by clicking the option you want.

■ If you are using System.Disk as your startup disk, you must select Printer.

■ If you are working with a completely installed version of System 6 (refer to Chapter 2 of 
the Apple IIgs System 6 User’s Reference), select the port you ’re using for your printer— 
either Printer or Modem.

Double-check to make sure that you’ve connected your printer to the port you’ve selected 
in the Control Panel.

Then make sure your port settings are correct, and that your slot settings match your port 
configuration. For more information about slot settings, refer to “Slots,” in Chapter 7 of the 
Apple llGS System 6 User’s Reference.

Select a printer type by clicking the name of the printer you’re using.

When you’ve made your selections, you can close the DC Printer Control Panel by clicking 
the close box.
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Printing a document
Try this procedure by printing your RevisedMemo. When you’re ready to print any other 
document, you can follow the same steps.

1 Insert your Practice.Disk into the disk drive.

2 Find and open the RevisedMemo icon.

You need to:

■ open your disk icon

■ find the Memos folder in its directory window and open it

■ open the document

Remember that when you open a document, you also open the program used to create that 
document.

3 Choose Print from the File menu.

Most programs present a dialog box in which you can select options related to printing. The 
appearance of the dialog box depends on both the type of printer you are using and the 
type of program you opened.

For example, if you have an ImageWriter II printer and you open a document created with 
Teach, your dialog box might look something like this.

Don’t be concerned about the printing options right now. The factory settings—the settings 
that are in effect automatically, until you change them—give you one copy of your entire 
document.

4 Click OK in the dialog box.

Your memo is printed.
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Congratulations!
You’ve finished all the basic skills exercises. The remaining chapter contains information on 
how to connect devices to your computer so that you can expand your computer’s 
capabilities when you’re ready to.

See the Apple IIgs System 6 User’s Reference and the manuals that came with your 
applications for more information as you begin your own work.
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9 Connecting Additional Devices

You may want to connect one or more of the many optional devices that increase the 

usefulness of the Apple IIgs computer. This chapter contains information about connecting 

such peripherals—printers, modems, disk drives, internal cards, SCSI devices, additional 

memory, and Pioneer laserdiscs. It also includes a brief listing of other peripheral devices 

that you might want to connect to your computer.

The instructions here assume that you’ve already set up your computer and attached the 

keyboard, mouse, monitor, and startup drive.

A Important Your computer should be switched off, but its power cord should be plugged 
into a grounded outlet. (Leaving the power cord plugged in keeps the computer 
grounded.) If the power has been on, wait at least 15 seconds after switching it off before 
you connect or disconnect any devices or interface cards. When plugging devices into an 
outlet, be sure to use a grounded outlet. A



Additional Memory
You can increase the amount of system memory with the Apple IIgs Memory Expansion 
Card and up to three Apple II256K Memory Expansion Kits.

The memory expansion card alone adds 256K of RAM to the Apple IIgs. And each 
memory expansion kit adds another 256K. Thus, a fully loaded memory expansion card— 
that is, one with three memory expansion kits installed—adds an entire megabyte of RAM.

Installing your memory expansion card

This section explains how to install the memory expansion card in the Apple IIgs. If you 
purchased one or more memory expansion kits, ask your authorized Apple service provider 
to install the kits on the memory expansion card before you install the card.

Follow these steps to install the memory expansion card:

If the computer is on, switch off the computer’s power, but leave the power cord 
plugged into a grounded outlet.

110 Chapter 9 Connecting Additional Devices



.L Remove the lid of the Apple IIgs.

Touch the power supply case inside the computer.

Touching the power supply case discharges any static electricity that may be on your 
clothing or your body.
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If necessary, remove the memory expansion card from its antistatic plastic bag.

The two small plastic jumper blocks that come with the memory 
expansion card are used when memory expansion kits are installed on 
the card. If your authorized Apple service provider has installed three 
memory expansion kits for you, he or she will also have installed both 
jumper blocks. (Only one of the jumper blocks is used when installing 
one or two kits.)

♦ Note Be sure to set any unused jumper blocks aside in a safe place—your service 
provider will need them if you decide to add more memory to the card later. ♦

Important When you handle the card, avoid touching the gold connector along the 
bottom edge. The oils and moisture from your fingers can attract dust that would interfere 
with the card’s connection to the computer. A

5 Insert the card in the memory expansion slot.

Looking at the computer from the front, the memory expansion slot is located in the lower- 
right corner. The side of the card with the integrated circuits should face to the left—that is, 
toward the power supply case.

Align the gold connector with the memory expansion slot. Then rock the card gently 
forward and back—keeping it perpendicular to the main circuit board—until it’s firmly 
seated in the slot. You may have to exert some pressure to seat the card securely in the slot, 
but don’t wiggle it from side to side.

♦ Inserting other cards If you have peripheral devices that must be connected to the 
computer through interface cards rather than directly into ports, you may want to install 
the interface cards now, while you have the computer’s lid off. For more information, see 
Devices with interface cards on page 114. ♦
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Replace the computer’s lid.

Lay the front edge of the lid in the groove in the front of the computer’s case and lower the 
back edge of the lid into place. Press down on the back corners of the lid until you hear the 
latches snap shut.
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Devices with interface cards
Some peripheral devices are designed to be connected to the Apple IIgs through interface 
cards that you insert into slots on the computer’s main circuit board. The peripheral device 
is then attached to a connector on the card. These interface cards contain special circuitry 
required for the computer to communicate with the attached devices.

Other interface cards add capabilities unrelated to peripheral devices. For example, the 
Apple II Video Overlay Card lets you superimpose computer-generated text and graphics 
on video images from an external source, such as a laserdisc.

For instructions on installing interface cards, see the manual that comes with each card.

A Important Some interface cards designed for the Apple He won’t work in the Apple IIgs. 
In most cases, the functions you need to add to the Apple lie by installing cards (faster 
processing, an 80-column display, RGB color, additional memory) are built into the Apple 
IIgs. If you have any questions about whether a card will work with your Apple IIgs, consult 
your authorized Apple service provider. A

Some devices that require interface cards to work with other models of the Apple II can be 
plugged directly into ports on the Apple IIgs, provided that the connector on the device’s 
cable matches the port on the computer’s back panel. (In the case of a serial printer or a 
modem, you can use the port even if the connectors don’t match; just get an Apple IIgs 
peripheral adapter cable from your authorized Apple dealer.)

If you’re installing an Apple II High Speed SCSI Card, read SCSI hard disks, CD-ROM 
drives, and other SCSI devices on page 125, for special guidelines about connecting SCSI 
devices.

UniDisk 3-5-inch disk drives can be connected either to an interface card in a slot or to 
the disk drive port. If you connect a UniDisk drive to an interface card, you must set the 
System Speed to Normal in the General Control Panel. For instructions on connecting a 
UniDisk drive to the disk drive port, see Disk Drives on page 116.

Before you connect any devices with interface cards, you should know which slots to 
use. Keep in mind that when you connect a device to a card in a slot, you won’t be able to 
use the corresponding port to connect another device. Figure 9-1 shows the back panel 
configuration of the Apple IIgs.
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Power cord socket On/off switch

Modem port

Headphone 
jack

Port openings

Monochrome or 
composite color 
monitor port

ADB port for 
keyboard and 
mouse

Printer port (also for another 
serial device or LocalTalk 
network)

Hand-operated 
control port 
(for joystick, 
game paddles)

Disk drive 
port or 
Smart Port

Analog RGB color 
monitor port

Security cable connector

Figure 9-1 The back panel of the Apple IlGS

The following table shows the recommended slots for several types of devices, as well as 
the corresponding port that will be unavailable. If the device you’re connecting isn’t listed 
in the table, use the slot recommended in the manual that came with the device.

Table 9-1 Recommended slots for peripheral devices

Slot Interface card Corresponding port

Slot 1 Printer Printer port

Slot 2 Modem Modem port

Slot 3 No card None

Slot 4 Primary input device ADB port (keyboard/mouse)

Slot 5 3.5-inch disk drive Disk drive port (if used for 3.5-inch drives)

Slot 6 5.25-inch disk drive Disk drive port (if used for 5.25-inch drives)

Slot 7 Any Card None
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For more information on recommended slots, see “Slots,” in Chapter 7 of the Apple IIgs 
System 6 User’s Reference.

▲ Warning If you install three or more cards—including the memory expansion card—you 
should also install a fan to keep your system from overheating. Fans for the Apple IIgs are 
available from your authorized Apple service provider. Installation instructions come with 
the fan. ▲

Disk drives

You can connect two kinds of disk drives to the Apple IIgs through the 
disk drive port: 3.5-inch drives and 5.25-inch drives. If you connect an 
Apple SuperDrive to the disk drive port, you will be able to use only 800K 
of disk capacity. To take advantage of the full capacity of 1.4 megabytes, 
you must install an Apple II 3.5 Disk Controller Card. Refer to the manual 
that comes with the card for connection procedures.

To daisy-chain disk drives, you connect the first drive directly to the disk drive port on the 
computer (or the controller card, in the case of the Apple SuperDrive), then you connect 
the second drive to the first drive, and so on.

You can daisy-chain as many as four drives to your computer, but the following limits apply:

■ only two Apple 3-5 800K Drives

■ only two Apple SuperDrives

■ only two Apple 5-25 Drives

■ up to four UniDisk Drives (which would be the maximum allowed for the port)

You can also connect a hard disk to the Apple IIgs, but you do so through an add-on, or 
external, card in a slot inside the computer rather than through the disk drive port. For 
instructions on connecting hard disks, see page 127.
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Connecting additional drives

Follow the instructions on page 10 in Chapter 1 to connect your first two Apple 3-5 disk 
drives. To connect additional disk drives to your computer, repeat steps 3 and 4 for each 
additional drive you want to connect.

Keep in mind that you shouldn’t daisy-chain more than four drives to the disk drive 
port. The daisy chain of disk drives connected to the disk drive port should be arranged 
with the 3-5-inch disk drives closest to the drive port or card and the 5-25-inch drives 
attached after the 3-5-inch drives. If you are using only 3-5-inch drives, remember that the 
Unidisk 3-5-inch drives must be attached after the Apple 3-5 drives.

♦ Note If you don’t know whether your 3-5-inch disk drive is an Apple 3-5 Drive or a 
UniDisk, the easiest way to tell is by color: Apple 3-5 Drives are platinum (the same color as 
the Apple IIgs), and UniDisk drives are white. The drives also have identifying labels on 
their undersides. ♦

If you have more than one drive of the same type, use the labels that came with the drives 
to specify which is drive 1 (the first drive in the chain) and which is drive 2 (the second drive 
in the chain).

Note that before you can use a 5-25-inch drive, you must use the Installer program to 
add the appropriate update to your startup disk. For more information, see Chapter 2 of 
the Apple IIgs System 6 User’s Reference.

Modems
A modem (short for modulator/demodulator) is a device that converts (modulates) digital 
computer signals into analog tones that can be sent over phone lines. A modem on the 
receiving end then converts (demodulates) the analog tones to their original computer- 
readable digital signal form.

Modems allow you to transfer data between your computer and other computers 
around the world using telephone lines.

There are two kinds of modems: direct-connect and acoustic-coupler. With a direct- 
connect modem (the more common variety), you plug the modem directly into the phone
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jack. With an acoustic-coupler modem, you put the telephone handset into a pair of rubber 
cups.

Connecting your modem

The instructions in this section are for direct-connect modems. If you have an acoustic­
coupler modem, refer to the setup instructions in the manual that came with the modem. 
Figure 9-2 shows how to connect a modem to your Apple IIgs.

Figure 9-2 Connecting a modem

Follow these steps to connect a modem to the Apple IIgs:

I Connect either end of the modem cable to the modem.

A Important Some modems (the Apple Modem 2400 is an example) have two serial port 
connections—one of them with an icon of a modem port, and the other with the icon of a 
computer. If your modem offers such a choice, connect your cable to the computer icon 
connection on the modem. A
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Connect the other end of the modem cable to the modem port on the back of the 
computer.

Modem port icon

Modem port

Disconnect the telephone cable from your telephone and connect it to the phone 
jack on your modem.

If your modem has no such icon, refer to the instructions that came with the product.

Using the phone cable provided with your modem, connect your telephone to 
the jack with the phone icon on your modem.

If your modem has no such icon, refer to the instructions that came with the product.

Plug the modem’s power connector or power cord into the modem.

Plug the modem’s power supply or power cord into a grounded outlet.

If you have trouble communicating with other computers through your modem, you may 
need to use the Modem Port Control Panel to change the configuration of the modem port. 
For instructions, see Chapter 7, “Using the Desktop Control Panels,” in the Apple llGS 
System 6 User’s Reference.

Pioneer laserdisc players
You can work with a Pioneer laserdisc player attached to your computer. You can then use 
the multimedia programs described in the Apple llGS System 6 User’s Reference chapter on 
“Controlling Multimedia Devices,” to control the laserdisc players via your computer. Be 
sure to read the manuals that come with the laserdisc players carefully.
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To display the Pioneer 2000,3030, and 4200 laserdisc video output on your computer’s 
monitor, you need an Apple II Video Overlay Card. You also need to use the Installer to add 
the appropriate updates to your startup disk. For details about the updates you need for the 
programs and equipment you want to use, see Chapter 11 of the Apple IIgs System 6 User’s 
Reference.

Follow these steps to connect the Pioneer laserdisc players to your Apple IIgs:

Install the Apple II Video Overlay Card in one of the computer’s internal slots.

For instructions, see the Apple II Video Overlay Card Owner’s Guide.

Connect one end of the video cable that comes with the Pioneer laserdisc player 
to the input jack on the Apple II Video Overlay Card ribbon cable.

Connect the other end of the video cable to the output jack on the laserdisc 
player.

Connect the Video Overlay Card monitor ribbon cable to your monitor.

Connect the cable used for computer control of the laserdisc.

For this connection, you must purchase a separate cable from the vendor who sold you 
your laserdisc player.

If you’re using the Pioneer 2000 or3030 laserdisc, the appropriate cable is a CTRL-cable 
with a “game I/O” connector on one end. The game I/O connector should have a notch on 
one end, which should be aligned with the notch on the game I/O socket in the computer. 
Connect the cable to the Game Port.

If you’re using a Pioneer 4200, the appropriate cable is a serial cable; connect it to the 
modem or printer port.

Plug the laserdisc player power cord into a grounded outlet.
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Figure 9-3 Connecting an ImageWriter II printer

Printers
Printers can be divided into two general categories: serial printers and parallel printers. 
Both can be used with the Apple IIgs. A serial printer receives information from the 
computer over a single wire; a parallel printer receives information over several wires at the 
same time.

You can plug serial printers into the printer port on the back panel of the Apple IIgs. 
Parallel printers require an interface card. If you have a parallel printer, turn to Devices with 
interface cards on page 114.

The instructions in this section are for local printers—printers that you connect directly 
to the computer and that can be used only from your computer. If your Apple IIgs is part of 
a network and you’ll be using shared printers over the network, refer to the LocalTalk® 
Cable System Owner’s Guide for instructions on connecting the printer to the network.

To connect an ImageWriter II or similar printer

Connecting your Apple IIgs to an ImageWriter® II is shown in Figure 9-3 • Follow these steps 
to connect an ImageWriter II or similar printer to the Apple IIgs:

Connect either end of the printer cable to the printer.
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Connect the other end of the printer cable to the printer port on the back of the 
computer.

If necessary, you can use the modem port instead.

Printer icon

Printer port

Modem port icon

Modem port

j Plug the printer’s power cord into the printer.

Plug the three-prong end of the power cord into a grounded outlet.

Install the appropriate printer update on your startup disks.

For instructions on installing the appropriate update, see Chapter 2, “Using the Installer," 
in the Apple 11GS System 6 User’s Reference.

6 Use the DC Printer Control Panel to specify the printer type and the port to which 
the printer is connected.

=D^= DC Printer

Select o Port: 
| Modem ~

Printer

Select a Printer Type:
ImogeWriter
LaserWriter

Note that the DC Printer Control Panel is not available unless you have installed the 
appropriate printer driver update, as noted in step 5.

For more information about the DC Printer Control Panel, see Chapter 8, “Printing Your 
Work,” on page 103.
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Make sure your slot settings match your port configuration.

For more information about slot settings, see Chapter 7 of the Apple Iles System 6 User’s 
Reference.

You can find more information about printing by referring to the manuals that came with 
your printer and with the applications you used to create your documents.

To connect PostScript-compatible LaserWriter or AppleTalk 
ImageWriter printers

To connect a PostScript*-compatible LaserWriter® or an AppleTalk® ImageWriter printer to 
your Apple IlGS, you need to create a “mini-network” using two LocalTalk Locking 
Connector Kits.

Follow these steps to connect the printer:

Connect the cable of one LocalTalk connector box to the printer port on the back 
panel of the computer.

If necessary, you can use the modem port instead.

Connect the cable of the other LocalTalk connector box to the printer.
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Connect either end of a LocalTalk cable to one of the sockets on the LocalTalk 
connector box connected to the computer.

4 Connect the other end of the LocalTalk cable to one of the sockets on the 
LocalTalk connector box connected to the printer.

A Important The two LocalTalk connector boxes should be connected by only one
LocalTalk cable. In other words, one socket on each connector box should be empty. A

Install the LaserWriter or AppleTalk ImageWriter update on your startup disks.

For instructions on installing the update, see Chapter 2, “Using the Installer,” of the Apple 
Hgs System 6 User’s Reference.

6 Use the NetPrinter Control Panel to choose the printer.

Het Printer

For instructions, see Chapter 12, “Networking the Apple IIgs,” in the 
Apple IIgs System 6 User’s Reference.

124 Chapter 9 Connecting Additional Devices



Make sure that AppleTalk is selected in the appropriate slot for the port to which 
you’ve connected your printer, and that slot 7 is set to AppleTalk.

For information about slot settings, see “Slots,” in Chapter 7 of the Apple IIgs System 6 
User’s Reference.

For instructions on printing, see Chapter 8, starting on page 103, of this manual, or refer to 
the manuals that came with your printer and with the application you’re using.

SCSI hard disks, CD-ROM drives, and other SCSI devices
The Small Computer System Interface (often shortened to SCSI, which is pronounced 
“SKUH-zee”) is a standard used by many manufacturers who develop hardware and 
software products for use with personal computers such as the Apple IIgs. SCSI provides a 
fast and reliable way for computers and peripheral devices to exchange information.

SCSI is fast because it allows your computer and your SCSI peripheral devices to 
exchange eight bits of information at once, along separate tracks, in parallel, rather than 
sending bits one at a time, or serially.

You can connect as many as seven SCSI devices in a chain to each SCSI card you install 
in the computer using a special set of cables called the Apple SCSI cable system, shown in 
Figure 9-4.

Here’s a summary of what you'll need:

■ Apple II High-Speed SCSI Card.

■ A SCSI system cable, for the first SCSI device you connect.

■ A SCSI cable terminator, to connect at the end of the chain.

■ For each additional SCSI device, you need a SCSI peripheral interface cable.

■ If you want to position the devices more than 18 inches apart, you may need one or 
more SCSI cable extenders.

In all cases, only one cable terminator should be used, installed at the end of the chain.
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Figure 9-4 The Apple SCSI cable system

Setting the SCSI ID numbers of your devices

The computer and each SCSI device connected to a SCSI card must have a unique ID 
number between 0 and 7. This number gives the computer’s operating system a way of 
identifying devices in a SCSI chain and determines the priority of the devices.

The computer’s ID number is normally 7—the highest priority. The devices in the SCSI 
chain can have ID numbers from 6 to 0. Each device must have its own number. Here are 
some guidelines to help you decide what ID numbers to assign:

■ If you want to use a SCSI device as your startup device, set its ID number to 6—next in 
priority after the computer itself.

■ If you want to connect two or more devices, set ID numbers according to the frequency 
with which you’re likely to use the devices—higher numbers for devices used more 
frequently.

Refer to the manual that came with your device for instructions on setting the SCSI ID 
number.
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Important You can have no more than seven devices in a SCSI chain. The total length of 
the cable system you use in a SCSI chain must not exceed 20 feet (6.5 meters). A

Connecting SCSI devices

Assuming you have installed an Apple II High-Speed SCSI Card according to the 
instructions that came with it, follow these steps to connect a SCSI device to your Apple 
IlGS:

If necessary, switch off the computer’s power, but leave the power cord plugged 
into a grounded outlet.

Connect the 25-pin (small) end of the SCSI system cable to the SCSI card’s ribbon 
cable connector and tighten the thumbscrews.
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3 Connect the appropriate cable to the SCSI device.

■ If you aren’t using a cable extender, connect the 50-pin (large) end of the SCSI system 
cable to the lower SCSI connector on the back of the SCSI device and snap the clips into 
the clip brackets to secure the connection.

■ If you are using a cable extender, connect one end of the cable extender to the 50-pin 
(large) end of the SCSI system cable and snap the clips into the clip brackets to secure 
the connection. Then connect the other end of the cable extender to the lower SCSI 
connector on the back of the SCSI device and snap the clips into the clip brackets to 
secure the connection.

■ If you’re connecting multiple devices, connect either end of a SCSI peripheral interface 
cable to the upper SCSI connector on the back of the first device and snap the clips into 
the brackets to secure the connection.

Then connect the other end of the SCSI peripheral interface cable to the lower SCSI 
connector on the back of the second device and snap the clips into the clip brackets to 
secure the connection.

Repeat for each additional device you want to connect.
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Connect a SCSI cable terminator to the upper SCSI connector on the back of the 
last SCSI device in the chain and snap the clips into the clip brackets to secure 
the connection.

j Plug the SCSI device’s power cord into the device.

6 Plug the three-prong end of the power cord into a grounded outlet.

Switch on the SCSI device.

For multiple devices, repeat steps 5 through 7 above for each device.

8 Restart the computer.
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Other peripheral devices
There’s a wide variety of other peripheral devices you can attach to your computer. Your 
authorized Apple service provider can help you learn more about the devices available for 
the Apple IIgs.

♦ By the way If a hand-operated control, a graphics tablet, a plotter, or other device is 
described as an Apple Desktop Bus (ADB) device, you attach it to the Apple Desktop Bus 
port on the back panel of the Apple IIgs (where the keyboard is usually plugged in) or to 
the connector on the keyboard (where the mouse is usually plugged in). ♦

Any time you connect an ADB device, be sure the computer is switched off and plugged in. 
If the computer has been on, wait at least 15 seconds after switching off the power before 
you connect or disconnect any ADB devices.

The following list should give you an idea of the variety of devices you can use with your 
Apple IIgs.

■ Adaptive devices for the disabled-. A number of adaptive devices are available for the 
Apple IIgs.

■ Hand-operated controls: Hand-operated controls (such as joysticks and game 
paddles) are used mostly to control the movement of creatures and objects in games. 
You can plug many hand-operated controls into the port on the back panel marked with 
the icon of a joystick.

■ Graphics tablets: As the name implies, a graphics tablet is a device for drawing pictures. 
Signals sent out by a special pen are detected by wires in the tablet and sent to the 
computer as x and y coordinates that can be displayed on the screen.

■ Light pens: A light pen sends instructions to the computer when you point to choices 
on the screen. It works with applications designed to receive input from a light pen.

■ Headphones: You can connect headphones to your Apple IIgs; you plug them into the 
jack on the back panel marked with a headphone icon.

■ Audio digitizers: An audio digitizer lets you input sounds from a stereo system, an 
electronic instrument, or a microphone. The sounds are recorded on a disk in digital

130 Chapter 9 Connecting Additional Devices



■ Graphic digitizers: A graphic digitizer converts photographic images into a digital form 
that the computer can display on the screen, save on a disk, and print.

■ Scanners: With a scanner you can scan pages of text or graphic images into a 
computer—a valuable service if you have a lot of paper documents that need to be 
entered into your computer. In conjunction with optical character recognition (OCR) 
software you can convert scanned words from a bitmap to an ASCII file that can be 
opened with word processing software.

■ Plotters: A plotter allows you to draw charts, graphs, floor plans, and similar graphics 
by means of pens whose movements are controlled by the computer.

■ Coprocessor cards: A coprocessor card is an interface card containing a 
microprocessor that works with or overrides the microprocessor that comes with your 
computer. With a coprocessor, you can take advantage of software developed for other 
computers—software that wouldn’t otherwise work on an Apple IIgs.

One common coprocessor card is the PC Transporter card, which lets you use 
applications based on the MS-DOS operating system (the operating system used with 
IBM PCs and compatible computers). With this card installed in your Apple IIgs, you can 
run MS-DOS applications.

■ Home control devices: You can attach a home control device to an electrical outlet and 
program it to turn on a light, a coffee maker, a radio, a sprinkler, or another appliance.

You can learn more about these and other devices by reading computer magazines or 
visiting your authorized Apple dealer.
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A References

This appendix gives a list of reference manuals about the Apple IIgs and related topics.

Reference manuals
The following manuals, published by Apple or by Addison-Wesley Publishing Company, Inc. 
(except where noted), are available at selected bookstores or directly from Apple.

Overview

Programmer’s Introduction to the Apple IIgs

Technical Introduction to the Apple IIgs

The Apple IIgs Book

The Apple II Guide

Firmware and hardware

Apple IIgs Firmware Reference

Apple IIgs Hardware Reference, Second Edition



Development environment

Apple IIgs GS/OS Reference

Apple Ugs GS/OS Device Driver Reference

Apple IIGS Programmer’s Workshop C

Apple IIgs Toolbox Reference, Volume 1

Apple IIgs Toolbox Reference, Volume 2

Apple IIgs Toolbox Reference, Volume 3

HyperCard IIGS Script Language Guide

ProDOS 8 Technical Reference Manual

Apple IIgs ProDOS 16 Reference

Related manuals

Apple Human Interface Guidelines: The Apple Desktop Interface

Apple Numerics Manual

Applesoft BASIC Programmer’s Reference Manual

Apple lie Technical Reference Manual

Apple He Technical Reference Manual

BASIC Programming With ProDOS

Inside AppleTalk

Programming the Apple IIgs in Assembly Language, Brady Communications (a division of 
Simon & Schuster), 15 Columbus Circle, New York, NY 10023. Also available from the 
author: Ron Lichty, P.O.Box 27262, San Francisco, CA 94127.
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User Groups
Call (800) 538-9696 or ask your authorized Apple dealer for the name of the Apple user 
group nearest you. For names of user groups outside the United states, or if you are 
interested in starting your own user group, contact:

Boston Computer Society
One Center Plaza
Boston, MA 02108
U.S.A.
(617) 367-8080

The Apple II Guide
The Apple 11 Guide is the definitive resource for all users of all Apple II computers. The 
Apple 11 Guide provides over 200 pages of history, success stories, technical and user-level 
information, advice, resources, and support information. The Guide is your ‘one stop 
shopping’ tour of the many uses and resources available to make your Apple II computer 
and your computing experience the best that it can be.
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B Basic Computer Information

This section defines many frequently used computer terms. If you already know the 

difference between hardware and software, and between RAM and ROM, you probably 

don’t need to read this section. Still, you may want to skim it to see whether there are any 

boldface terms you don’t recognize.



Hardware

The components that make up your computer system—computer, monitor, keyboard, 
mouse, disk drives, cables, power cords, and so on—are known collectively as hardware. 
Hardware includes all equipment you can actually touch.

If you take the lid off your computer, you see the main circuit board—a fiberglass 
board that contains embedded circuitry with a number of small electronic components 
attached. These are known as integrated circuits (or, in computer jargon, chips). One of 
the integrated circuits—the one that functions as the “brain” of the computer—is called the 
central processing unit (CPU) or the microprocessor. The CPU in the Apple IlGS is 
called the 65816 microprocessor. The term CPU is occasionally used to refer to the entire 
device—the computer itself—that contains the central processing unit.

A computer alone wouldn’t be of much use to most people. You need other 
components in order to communicate information to the computer, see the information in 
a useful form, store the information permanently, and print a copy on paper (called hard 
copy). Because these other components are at the periphery of the CPU, they’re called 
peripheral devices. This term applies even when such devices are located inside the 
computer housing, as in the case of peripheral cards.

Software

Computer programs are sets of instructions that tell the computer how to perform a 
particular task. Programs are known collectively as software. There are two kinds of 
software: the programs that the computer uses to run itself, called system software; and 
programs designed to help you perform specific tasks, called application software. These 
tasks can include, but are not limited to, word processing, calculating, and drawing.

System software and application software are commonly stored on disks—flat, circular 
surfaces, housed in square plastic casings, where information is stored magnetically. The 
term disk (and sometimes the term volume) is also used to describe storage areas that are 
not physical disks but that function as disks, such as hard disk partitions, RAM disks, and 
file server volumes.

A disk that contains system software is known as a startup disk—as opposed to a data 
disk, which contains information created with the computer, but no instructions telling the 
computer how to run.
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Firmware, ROM, and RAM

Some programs are known as firmware because they’re stored in the computer’s 
permanent memory. That memory is called read-only memory (ROM) because the 
computer can use (or “read”) the information stored there, but the information can’t be 
changed. The programs stored in ROM give the computer such basic instructions as what 
to do when you switch on the power.

When you’re doing work with the computer—writing a report or creating a budget, for 
example—your work is stored in the computer’s internal working memory. This memory 
is called random-access memory (RAM) because the information stored there can be 
referred to in a random order, just as a book can be opened randomly to any page.

It’s important to remember that RAM is temporary memory. Information in RAM isn’t 
retained when the computer’s power is switched off. For that reason, you must always save 
your information on a disk before you switch off the computer. And because accidents such 
as power failures sometimes happen, it’s a good idea to save your work frequently during 
your work sessions as well.

RAM can hold data or instructions to the computer. When you see an “out of memory” 
message while you’re working with your computer, the message means that you don't have 
enough RAM to hold both the data in your project and the instructions required by the 
application you’re using.

The binary system of bits and bytes

Whenever information is manipulated in RAM or transmitted between the computer and 
another device, the information must be translated into the computer’s language—a system 
of 0’s and l’s known as the binary system. When you type characters at the keyboard, for 
example, the computer understands them as a pattern of 0’s and l’s. This system is 
perfectly suited for computers because their microprocessors are made up of switches­
like light switches—that can be either on or off. On is usually represented as the number 1, 
off as 0.

Computer memory is customarily measured in units called bits and bytes. A bit is 
enough memory to store one binary digit—a 0 or a 1. (In fact, the word bit is a shortened 
form of the term binary digit.) A byte is enough memory (by convention 8 bits) to store 
a single letter, number, punctuation mark, or other character. But since even the byte is a 
very small unit of measure, it’s more convenient to refer to memory in larger units. A
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kilobyte (K) is equivalent to 1024 bytes. And a megabyte (MB) is equivalent to 1024 
kilobytes—that’s 1,048,576 bytes!

User interface

Interface is a word you may see a lot in computer books and magazines to describe a 
method of communicating physical, electrical, and visual information. The way information 
is communicated between a computer and a person is called the user interface.

Every application program has its own user interface. In fact, you might think of the user 
interface as the application’s personality. Some applications guide you slowly and 
methodically through every step of a process; others give you minimal instruction and let 
you take it from there.

One important aspect of an application’s user interface is the method with which the 
computer displays information on the screen. Many applications use a graphics mode, in 
which images are formed by patterns of dots, called pixels, on the screen. (The word pixel 
is a shortened form of the term picture element.) The more dots used to create an image 
on the screen, the higher, or sharper, the image’s resolution will be. The Apple IlGS 
supports the Super Hi-Res graphics mode (which allows a graphics display of either 320 
or 640 horizontal pixels by 200 vertical pixels on the whole screen) as well as the graphics 
modes used in other models of the Apple II family: Lo-Res, Hi-Res, and Double Hi-Res.

Despite the termgraphics mode, an application that displays information in a graphics 
mode isn’t limited to graphics. Text can be part of the picture, or even all of the picture. The 
application simply displays each character as if it were a picture. That’s why some word­
processing applications can display text in a variety of typefaces (often called fonts) and 
sizes.

In applications that use a text mode, the screen is divided into an invisible grid of 24 
vertical rectangles by either 40 or 80 horizontal rectangles. Each rectangle in the grid can 
hold a single character. The text generator, a combination of circuitry and firmware, 
places characters in the grid. The characters correspond to keys on the keyboard. In the 80- 
column format, you can fit twice as many characters per line as you can in the 40-column 
format, but the characters are half as wide.

Most graphics mode applications are mouse-based—that is, you use the mouse to give 
the computer instructions, or commands. Most text mode applications, on the other hand, 
are keyboard-based; you must rely entirely on the keyboard for issuing commands.
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Operating systems and file systems

An operating system is a set of programs, designed for a particular type of computer, that 
carries out certain tasks for the computer, such as data handling, memory management, 
printing management, and the transmission of information between the memory of the 
computer and the disks in the computer’s disk drives.

Application programs are designed to work with a particular operating system. You can 
think of the operating system as sort of a subcontractor for the application program: When 
you tell the application to save a document on a disk, for example, the application hands 
the job over to the operating system.

An important component of an operating system is its file system, or the way it 
organizes information on disks. When you save information on a disk, the computer needs 
a way to store that information for easy retrieval in the future. The file system provides the 
organizational structure that allows the computer to find information on the disk.

A disk that has never been used can’t be recognized by any file system. You prepare the 
disk to receive information in a process called initializing the disk. When you initialize a 
disk, the computer divides it into a format of tracks and sectors (sections where 
information can be stored) and adds the file system. Because formatting a disk is part of 
the initialization process, you may see the term formatting used instead of initializing in 
some books or magazines.

Initializing a disk is somewhat like creating a parking lot with numbered spaces. The 
tracks and sectors are like the lines separating the individual parking spaces; the file system 
is like the numbering system for the spaces.

Different kinds of computers use different operating systems—and every operating 
system uses one or more file systems. As a result, when you insert a disk that has a “foreign” 
file system, most computers won’t know how to store or retrieve information on that disk.

Until recently, most Apple IIgs applications used an operating system called ProDOS (an 
abbreviation for Professional Disk Operating System). Like other operating systems, 
ProDOS has its own file system. The newest Apple IIgs operating system—called GS/OS® 
for short—can recognize ProDOS disks as well as disks initialized for other file systems.

An individual floppy disk is formatted with only one file system, and is commonly called 
a “ProDOS disk” or an “HFS disk.” In the past, each different type of CPU had its own file 
system. However, it’s now sometimes possible to use more than one file system on one 
computer—as is the case with your Apple IIGS computer.

When you insert a disk initialized for the ProDOS file system, GS/OS automatically 
recognizes it. If you want to use disks initialized for other file systems, you can use the
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Installer program on the Apple IlGS Install disk to add programs known as File System 
Translators (FSTs) to your startup disks. At present, the following file systems are 
available:
■ ProDOS, used by most Apple II applications.

■ HFS, used on the Macintosh computer (HFS stands for Hierarchical File System).

■ High Sierra, used on some CD-ROM discs that are designed to be used with any 
computer.

■ DOS 3.3 and Apple Pascal, two file systems used on early Apple II computers.

■ AppleShare, used to read and write information over a network to a shared Macintosh 
disk on an AppleShare file server.
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C Using the Text Control Panel Desk
Accessory

This appendix explains how to use the text Control Panel and its associated option 

modules. These programs let you customize various aspects of the computer’s operation. 

You can change the volume level of the computer’s sound, the pitch of the computer’s 

beep, the responsiveness of both the mouse and the keys on the keyboard, the flashing of 

the pointer or insertion point, and many more features. The Control Panel also includes a 

calendar and clock.

The first section of this appendix gives an overview of the Control Panel and explains the 

two ways of using it. The subsequent sections explain each Control Panel module and what 

its different settings mean.



About the Control Panel
The Control Panel feature is a desk accessory—that is, a “mini-application” that’s available 
regardless of what application you’re using. The settings for most Control Panel modules 
are stored in special, battery-powered RAM. Unlike ordinary RAM, the battery-powered 
memory retains what’s stored in it even after the computer’s power is switched off. As a 
result, the changes you make to Control Panel settings are saved for future sessions.

A Important If the battery is running low, the Control Panel automatically restores the 
original settings. If this happens, have your authorized Apple service provider replace the 
battery; then use the Control Panel again to change the settings back to your 
preferences. A

There are two versions of the Control Panel: The desktop Control Panels are a New Desk 
Accessory (NDA), and the text Control Panel, is a Classic Desk Accessory (CDA). The 
desktop Control Panels capabilities are covered in chapter 7 of the Apple IIgs System 6 User’s 
Reference. This appendix explains how to use the text Control Panel.

The text Control Panel is stored in the computer's ROM, so it’s available whenever the 
computer is on. When you aren’t using the Finder or another application that has an Apple 
menu, you use the text Control Panel to change settings.

The next two sections explain how to get to the Control Panel and how to make changes 
to each module. The remainder of the appendix explains all the options you can set in the 
Control Panel and what the different settings mean.
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Getting to the Control Panel
You can get to the text Control Panel from most applications—and even when you’re not 
using an application at all.

Follow these steps to get to the text Control Panel:

Switch on the computer’s power.

Hold down the Command and Control keys while you press and then release the 
Esc key.

You see the Desk Accessories menu.

ci: Desk Accessories

ane
Alternate Display 
Quit

Mode

Select: 4-'F Open :

If you’ve installed other classic desk accessories in the Desk.Accs folder (inside the System 
folder on your startup disk), they will also appear in the Desk Accessories menu. (New desk 
accessories, on the other hand, appear in the Apple menu of graphics-based applications 
such as the Finder.)

♦ Note Some applications don’t show you the Desk Accessories menu when you press 
Command-Control-Esc. If that’s the case with your application, you won’t be able to use the 
text Control Panel (or any other classic desk accessories) while using the application. To get 
to the text Control Panel you’ll have to quit the application and then press Command- 
Control-Esc. ♦
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3 Press Return to enter the text Control Panel.

You see the main menu of the text Control Panel.

Display
Sound
System Speed
Clock
Keyboard
Slots
Printer Port
Modem Port 
RAM Disk 
Mouse

wim

5 : 41 : PTT 
4/ 4/92

Seiect: 4" Open : +J

Making changes to Control Panel modules
It doesn’t matter whether you use the desktop Control Panels or the text Control Panel to 
make your changes—the changes are saved in the same battery-operated RAM and will 
show up in the other version of the Control Panel as well.

A few modules can be changed only in the desktop Control Panel. The description of 
each module (in Control Panel options on page 150) indicates whether the option can also 
be changed in the text Control Panel.

The text Control Panel main menu lists all the Control Panel modules you can customize; 
you can follow the same basic steps no matter what option you’re setting:

Press Down Arrow or Up Arrow until the Control Panel module you want is 
highlighted.

When you hold either key down, the highlighting cycles quickly through the choices.

2 Press Return.

You’ll see the menu of options for the Control Panel module you highlighted. In each case, 
the first option listed is highlighted.

3 If necessary, press Down Arrow or Up Arrow until the option you want to change 
is highlighted.
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i Press Right Arrow or Left Arrow until you see the setting you want.

Most of the Control Panel modules indicate the possible settings with words or numbers to 
the right of the option name. When you press Right Arrow or Left Arrow, you see the next 
setting; holding down either arrow key moves you quickly through the settings.

The Sound menu options and some of the Keyboard menu options indicate the possible 
settings with an asterisk on an indicator bar. The position of the asterisk on the bar shows 
the current setting relative to other settings along a continuum.

When you press Right Arrow or Left Arrow, the asterisk moves to the right or left, 
representing the new setting along the continuum.

The default setting for any option (the one set at the factory) is indicated with a check mark.

Repeat steps 3 and 4 for any other options you want to change on the same 
Control Panel module.

6 Press Return to save the new settings.

Or, if you change your mind about any of the settings, press Esc to cancel the changes.

Once you save a setting, the computer uses the new setting until you change it again. The 
check mark next to an option name always indicates the default setting—that is, the one set 
at the factory.

Pressing either Return or Esc takes you back to the main menu.

Repeat steps 1 through 6 to change options on other modules.

8 Quit the Control Panel.
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Control Panel options
The following tables show the options available under each of the text Control Panel 
menus. The sub-menus are listed in hierarchical order. The functionality of the settings is 
discussed in Chapter 7 of the Apple llGS System 6 User’s Reference

Apple Desk Accessories

Control Panel

Display Type

Columns

-Screen Colors-

Text

Background

Border

Standards

Sound Volume

Pitch

System Speed System Speed

Clock Month

Day

Year

Format

Hour

Minute

Second

Format
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BBCBCBBCBBBCEBEECSBBCBBB

Keyboard Display Language

Keyboard Layout

Keyboard Buffering

Repeat Speed

Repeat Delay

Cursor Flash 

-Advanced Features-

Shift Caps/Lowercase

Dual Speed Keys

Fast Space/Delete Keys

Slots Slot 1

Slot 2

Slot 3

Slot 4

Slot 5

Slot 6

Slot 7

Startup

Printer Port -Device Connected

Line Length

Delete first LF after CR

Add LF after CR

Echo

Buffering

Baud

Data/Stop Bits

Parity

DCD Handshake

DSR/DTR Handshake

XON/KOFF Handshake
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Quit

Modem Port -Device Connected

Line Length

Delete first LF after CR

Add LF after CR

Echo

Buffering

Baud

Parity

Data/Stop Bits

DCD Handshake

DSR/DTR Handshake

XON/XOFF Handshake

RAM Disk Select RAM Disk Size

Largest Selectable

-RAM Status-

RAM Disk Size

Total RAM in Use

Total Free RAM

Resize after Reset

Mouse Mouse Tracking

Double Click

Keyboard Mouse-

Delay-to-Start

-Acceleration

Maximum Speed
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Glossary

ADB Acronym for Apple Desktop Bus. A port on the back 
panel of the Apple IlGS for connecting the keyboard, the 
mouse, and other ADB devices. It’s called a “bus” because 
the signals sent by several devices can “ride” the same 
cable.

application program Any computer program designed 
for a particular purpose, such as home finance, education, 
or word processing. Application programs are often 
referred to as applications for short. Compare system 
software.

ASCII Acronym for American Standard Code for 
Information Interchange; pronounced “ASK-ee.” A 
communications code that defines the way letters, 
numbers, and punctuation marks are represented by the 
computer.

backup copy A duplicate of a disk or file, which you 
make as a safeguard in case anything happens to the 
original. Making a backup copy of a disk or file is like 
making a photocopy of a paper document.

binary system A numbering system in which every 
number is expressed as a combination of 0’s and l’s. The 
binary system is perfectly suited to computers because the 
computer’s microprocessor is made up of switches—like 
light switches—that are either on or off. On is usually 
represented as the number 1, off as 0.

bit Contraction of the words binary and digit. The 
smallest item of useful information a computer can handle, 
usually represented as a 1 or a 0. Eight bits equal one byte.

bitmap A set of bits that represent a graphic image.

boldface A name given to type that is heavier than the 
plain text type with which it is used.

byte A sequence of eight bits that represents an 
instruction, a letter, a number, or a punctuation mark.

chip An electronic circuit—including components and 
interconnections—entirely contained in a single piece of 
semiconducting material, usually silicon. Same as 
integrated circuit.

CDA (classic desk accessory) A “mini-application” that 
you can use without leaving your main application. Classic 
desk accessories are available from the Desk Accessories 
menu, which you can reach by pressing Command- 
Control-Esc whenever the computer is on.

close box The small box on the far-left end of the title bar 
of an active window. Clicking the close box closes the 
window.

CPU (central processing unit) The “brain" of the 
computer; the microprocessor that actually performs the 
computations in machine language. Some people use the 
term CPU to refer to the entire component—the 
computer—that includes the central processing unit.
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command An instruction that you give to the computer, 

cut To remove text or graphics from a document by using 
the Cut command. The most recent “clipping” is stored on 
the Clipboard of the Apple IlGS so that you can paste it 
somewhere else if you wish.

data disk A disk that contains your work—letters, 
budgets, pictures, and so on—but that contains no 
application programs. Compare program disk; startup 
disk.

desk accessory A “mini-application” that you can use 
without leaving your main application. See also classic 
desk accessory; new desk accessory.

desktop In graphics-based applications, the computer’s 
working environment on the screen. In the Finder, for 
example, the desktop displays the Menu bar, Trash icon, 
the icons of any disks to which you have access, and the 
windows of any disks or folders you’ve opened.

destination disk The disk onto which you are copying 
or moving data. (The source disk is the disk from which. 
you’re copying or moving data.)

dialog box A box that the Apple IlGS displays to request 
information or ask you to confirm an action. In many 
cases, dialog boxes containing warnings are accompanied 
by a beep.

directory dialog box A special type of dialog box, used 
in graphics-based applications, that allows you to open, 
save or relocate a file.

disk A flat, circular magnetic surface, made either of 
metal or of plastic coated with iron oxide. You can buy 
applications prerecorded on disks, and you save your 
work on blank disks. See also 5.25-inch disk; hard disk; 
3.5-inch disk.

disk directory A list of all the files on a disk. Sometimes 
called a catalog.

document A discrete collection of information you 
create with an application. Examples of documents are 
memos, pictures, and budgets. Compare file.

double-click To position the pointer where you want an 
action to take place, and then press and release the mouse 
button twice in quick succession without moving the 
mouse.

Double Hi-Res A graphics mode that can display 
information using a rectangular array of 560 horizontal by 
192 vertical dots for black and white and for 16 colors.

drag To position the pointer on something, press and 
hold the mouse button, move the mouse, and then release 
the mouse button. When you release the mouse button, 
you either highlight a selection or move an object to a new 
location.

file system A system for organizing the sections on a 
disk so that your application can keep track of where data 
is stored. You must initialize any disks you’ll be using with 
a particular application for use with that application’s file 
system.

file server A computer equipped with special software 
and one or more mass storage devices (such as hard disks) 
that allows computer users in a network to store and share 
applications, documents, and other information.

file server volume A disk connected to a file server that 
network users can employ to store and share information

file system translators (FST) A program that tells 
GS/OS how to read and write data to disks that use a 
particular file system, such as AppleShare or HFS.

Finder An application that helps you manage the way 
information is stored on disks. The Finder also lets you 
move quickly from one application to another.

firmware Programs stored permanently in read-only 
memory (ROM).
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floppy disk A disk made of flexible plastic that stores 
computer data. The term floppy was originally applied to 
disks with thin, flexible disk jackets, such as 5.25-inch 
disks, which were literally floppy and could be easily bent. 
With 3.5-inch disks, the disk itself is flexible, but the jacket 
is made of had plastic. Both kinds, however, are called 
floppy disks. Compare hard disk.

folder A subdirectory or an icon that represents a 
subdirectory. Folders give you a visual representation of 
documents that you have grouped together on a disk.

font A complete set of characters in one design, size, and 
style.

format The physical division of space on a disk into 
sections—somewhat like parking spaces in a parking lot— 
where information can be stored. A disk’s format is 
established as part of the initialization process.

graphics mode A way of displaying text and graphics on 
the screen. In a graphics mode, images are formed by 
patterns of dots.

GS/OS The current operating system for the Apple IlGS.

hard copy A printed copy of an electronic document.

hard disk A storage device that can hold much more 
information than a 3.5-inch disk or a 5.25-inch disk. Unlike 
3.5-inch and 5.25-inch disks, a hard disk is sealed into its 
drive and is not removable.

hardware Those parts of the computer system that you 
can see and touch. The computer, the peripheral devices, 
the cables used to connect them, and the cords that 
supply them with power. Compare software.

HFS (Hierarchical File System) The file system used 
by the Macintosh computer, HFS is one of the file systems 
currently support by GS/OS.

Hi-Res A graphics mode that can display information 
using a rectangular array of 280 horizontal by 192 vertical 
dots.

I-beam See insertion point.

icon (1) In graphics-based applications, a symbol on the 
screen that represents a disk, a document, or something 
else you can select. (2) A symbol on the back panel of the 
computer that shows you where to plug in a peripheral 
device.

initialize To divide a disk into sections where 
information can be stored and to write a file system on the 
disk so that an application can keep track of where data is 
located. Disks must be initialized before you can save 
information on them.

insertion point A blinking vertical or horizontal line that 
marks your place on the screen. The insertion point shows 
you where your next action will take place. Also called the 
cursor. Compare pointer.

Installer A program on the Apple IlGS Install disk that 
lets you add or remove capabilities from your startup 
disks. For example, if you’re connecting a SCSI hard disk, 
you need to install the “SCSI Hard Disk” update to your 
startup disks.

integrated circuit An electronic circuit—including 
components and interconnections—entirely contained in 
a single piece of semiconducting material, usually silicon. 
Often referred to as a chip.

interface The way things communicate. See also user 
interface.

kilobyte (K) A unit of measure for computer memory;
1 kilobyte equals 1024 bytes. See also byte; megabyte.

Lo-Res A graphics mode that can display information 
using a rectangular array of 40 horizontal by 48 vertical 
blocks.

main circuit board A large circuit board that holds 
RAM, ROM, the microprocessor, custom integrated 
circuits (chips), and other components.

megabyte (MB) A unit of measure for computer 
memory; 1 megabyte equals 1,048,576 bytes (each byte 
being enough memory to represent a single character). 
See also byte; kilobyte.
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menu A list of choices presented by an application.

menu bar In graphics-based applications, the horizontal 
strip at the top of the screen that contains menu titles.

microprocessor The “brain” of the computer; the 
integrated circuit that performs the actual calculations. 
Also called the central processing unit (CPU). The 
Apple IlGS has a 65C816,16-bit microprocessor.

modem Short for modulator/demodulator. A device that 
links your computer to another computer or to an 
information service over phone lines. See also acoustic­
coupler modem; direct-connect modem.

mouse The small device you roll around on a flat surface 
next to your computer. When you move the mouse, the 
pointer on the screen moves correspondingly.

NDA (new desk accessory) A “mini-application” that 
you can use without leaving your main application. New 
desk accessories are available from the Apple menu 
whenever you’re using the Finder or any graphics-based 
application that supports the Apple menu.

operating system A set of programs that, among other 
things, controls the way information is loaded into 
memory, the way the computer works with that 
information, the way information is stored on a disk, and 
the way the computer communicates with a printer and 
other peripheral devices. GS/OS, ProDOS 16, ProDOS 8, 
DOS 3.3, and Apple Pascal are some of the operating 
systems available for the Apple IlGS.

paste To insert a copy of the contents of the Clipboard— 
whatever was last cut or copied—at the insertion point.

peripheral device A device that’s connected to the 
computer, such as a printer or a modem.

pixel Contraction of the phrase picture element. A dot 
on the screen, used in graphics mode to form text and 
graphics.

pointer In graphics-based (desktop) applications, a 
marker that moves across the screen when you move the 
mouse across your desk. Compare insertion point.

port A socket on the back panel of the Apple IlGS for 
connecting peripheral devices.

PostScript The page description language used by some 
printers to define the appearance of text and graphics on 
the printed page.

press (1) To position the pointer on something and then 
hold down the mouse button without moving the mouse. 
(2) To hold down a key on the keyboard.

ProDOS Acronym for Professional Disk Operating 
System. One of several operating systems for the 
Apple IlGS. See also operating system.

program (v.) To write instructions for a computer.
(n.) A set of instructions that tells a computer what to do. 

program disk A disk that contains an operating system 
and a self-starting application program.

Random Access Memory (RAM) Built-in computer 
memory where applications and data are stored 
temporarily for the microprocessor. Anything stored in 
RAM is erased when you switch off the power; you must 
save the information on a disk if you want a permanent 
copy.

read-only The privilege to transfer information from a 
disk into the computer’s memory, but not to record 
information on a disk.

Read-Only Memory (ROM) Memory whose contents 
the computer can read but not change. Information is 
placed into ROM during manufacturing. Compare RAM.

resolution The degree of clarity of your display. An RGB 
color monitor has better resolution than a composite 
color monitor.

SCSI Acronym for Small Computer System Interface, 
pronounced “SKUH-zee.” An industry standard interface 
that provides high-speed access to peripheral devices and 
allows them to be daisy-chained to a single port or card.

slot A long, narrow socket inside the Apple IlGS that lets 
you connect a printer or other peripheral device to the 
computer by plugging in an interface card.
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software Instructions, usually stored on disks, that tell 
the computer what to do. Compare hardware.

source disk The disk from which you are copying or 
moving. (The destination disk is the disk onto which 
you’re copying or moving.)

startup disk A disk with the necessary software to start 
up the computer.

startup drive The disk drive in which the computer 
looks first for a startup disk.

Super Hi-Res A graphics mode that can display 
information using a rectangular array of 640 horizontal by 
200 vertical dots in 4 colors (per line) or 320 horizontal by 
200 vertical dots in 16 colors (per line). Up to 256 colors 
can be displayed on the screen at one time under normal 
circumstances. Special software enables up to 3200 colors 
at one time.

surge protector A device that protects your computer 
equipment from damage in the event of a surge of 
electrical current. Some power strips have built-in surge 
protectors.

System Folder A folder containing the files your 
computer uses to start up and operate.

system software Software that supports application 
programs by managing system resources such as memory 
and input/output devices.

text generator Circuitry and firmware that print 
characters on the screen in response to keypresses.

text mode A way of displaying text on the screen. In a 
text mode, characters fit in a 40-column by 24-line grid or 
in an 80-column by 24-line grid.

Trash An icon that represents the function of discarding 
files and folders when you no longer need them.

user interface The way information is exchanged 
between a computer and a person.

volume See disk; file server volume.

window In graphics-based applications, one or more 
areas on the screen showing the contents of disks, folders, 
and documents.
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